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ACCQPrep HP150 Installation and Operation Guide

Safety Overview
Refer to the document ACCQPrep® SFC Important Information 
(PN 69-5263-088) for the most current safety information. This 
document is included with your ACCQPrep system, and the 
latest version is available at www.teledynelabs.com.

Hazard Severity Levels
This manual applies Hazard Severity Levels to the safety alerts. 
These three levels are described in the sample alerts below.

CAUTION
Cautions identify a potential hazard, which if not avoided, may 
result in minor or moderate injury. This category can also warn 
you of unsafe practices, or conditions that may cause property 
damage.

WARNINGWARNING
Warnings identify a potentially hazardous condition which, 
if not avoided, could result in death or serious injury.

DANGER
DANGER – limited to the most extreme situations 
to identify an imminent hazard, which if not 
avoided, will result in death or serious injury.

Hazard Symbols
The equipment and this manual use symbols used to warn of 
hazards. The symbols are explained in the table below.

Hazard Symbols 

Warnings and Cautions

The exclamation point within the triangle is a 
warning sign alerting you of important instructions 
in the instrument’s technical reference manual.

The lightning flash and arrowhead within the trian-
gle is a warning sign alerting you of “dangerous 
voltage” inside the product.

The three wavy lines above the horizontal line 
within the triangle is a warning sign alerting you of 
a “hot surface” inside the product.
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Safety Warnings

Symboles de sécurité

Ce symbole signale l’existence d’instructions 
importantes relatives au produit dans ce manuel.

Ce symbole signale la présence d’un danger 
d’électocution.

Ce symbole signale la présence d’une surface 
chaude à l’intérieur du produit.

Warnungen und Vorsichtshinweise

Das Ausrufezeichen in Dreieck ist ein Warnze-
ichen, das Sie darauf aufmerksam macht, daß 
wichtige Anleitungen zu diesem Handbuch 
gehören.

Der gepfeilte Blitz im Dreieck ist ein Warnzeichen, 
das Sei vor “gefährlichen Spannungen” im 
Inneren des Produkts warnt.

Der drei Wellenlinien über der horizontalen Linie 
Dreieck ist ein Warnzeichen, das Sei vor “heißen 
Oberfläche” im Inneren des Produkts warnt.

Advertencias y Precauciones

Esta señal le advierte sobre la importancia de las 
instrucciones del manual que acompañan a este 
producto.

Esta señal alerta sobre la presencia de alto vol-
taje en el interior del producto.

Esta señal alerta sobre la presencia de superficie 
caliente en el interior del producto.

Hazard Symbols (Continued)
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ACCQPrep SFC Safety Considerations
Before installing, operating, or maintaining this equipment, it is 
imperative that all hazards and preventive measures are fully 
understood. While specific hazards may vary according to 
location and application, heed the following general warnings.

General Safety Guidance 

WARNINGWARNING
Avoid hazardous practices! If you use this instrument in 
any way not specified in this manual, the protection 
provided by the instrument may be impaired; this may 
increase your risk of injury.

Follow all applicable safety practices and regulations when han-
dling and moving the system’s shipping crate and associated con-
tainers, and when moving the system itself.

CAUTION
Lifting or Moving the Equipment 
When carrying or moving the instrument, use the supplied 
system handles and remove when complete. Holding by the 
sides or bottom of the instrument may result in pinched fingers 
causing injury or damage the instrument.

CAUTION
Installation 
Installation should be performed by Teledyne LABS qualified 
personnel. Do not carry multiple modules at the same time.

WARNINGWARNING
Safe Lifting Practice 
Keep the unit upright when moving. Be sure to follow your 
company’s procedures and practices regarding the safe 
lifting and relocation of heavy objects. Use a 2-person lift 
when moving or carrying the modules.

CAUTION
When opening the oven drawer, be careful to not pinch your 
fingers.

• Locate the system away from potential spark sources.
• See the warning below regarding placing the system.
• Keep the system’s power cord plug and outlet easily 

accessible in case the system needs to be disconnected 
quickly from AC power.
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• Install external fire protection conforming to local 
regulations

• Have plans in place that conform to local regulations to 
address solvent spills or leakage at your site to prevent 
a fire or explosion hazard.

WARNINGWARNING
Use of Flammable and/or Hazardous Chemicals and 
Solvents 
Chemicals used with this instrument may be classified as 
carcinogenic, bio-hazardous, flammable, or radioactive. 
Additionally, the use of flammable solvents or chemicals 
with this system may result in vapor concentration levels 
that exceed the maximum exposure levels as 
recommended by OSHA Guide 1910.1000. 
 
Do not use solvents with an autoignition temperature below 
200 °C. 
 
In all cases, use good laboratory practices, appropriate 
personal protective equipment, and standard safety 
procedures.  
 
Should these chemicals be used, Teledyne LABS highly 
recommends that these applications be performed in an 
isolated environment and/or a laboratory fume hood 
designed to reduce exposure to a safe level for these types 
of materials in accordance with federal, state, and local 
regulatory laws, and in compliance with your company’s 
chemical hygiene plan in the event of a spill.

WARNINGWARNING
Damage to System by Chemicals 
Do not allow chemicals to come into contact with the 
system’s power cord or cables. Solvents can degrade cord 
and cable insulation, causing a risk of electric shock, fire, 
and equipment damage.

CAUTION
Flowpath Under Pressure 
Before removing any component in the high-pressure flowline, 
such as tubing, the sample loop, in-line filter, column, etc. stop 
the pump and confirm the system pressure has fallen to zero.  
Depending on the position in the flow path the system may 
need to be vented via Manual Control to release the pressure 
completely. Removing any of these parts while high pressure 
remains could cause the mobile phase and the clogging parti-
cles to eject rapidly and injury could occur.
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CAUTION
Unintended Use of this Equipment 
Use of this instrument in any way not specified in the manual 
or the user not following on-screen prompts and messages 
may impair the protection provided by the instrument. 
 
Operators and maintainers of the system must be provided 
with all applicable health and safety regulations for use of the 
system, its accessories, and consumables. They must be edu-
cated, trained, and competent to use the machine as it is 
intended.

CAUTION
Possible Carbon Dioxide Expansion in Sample Path 
Ensure that the cosolvent pump is properly primed before use, 
after changing or refilling solvents, and when directed. 
 
If the cosolvent pump is not properly primed, CO2 can accu-
mulate in the cosolvent fluid path. CO2 in this fluid path could 
enter the sample injection flow path, creating a possibility of 
sample loss via expansion of CO2 to atmosphere through the 
sample probe. 
 
Ensure all sample introduction is done in an appropriately ven-
tilated hood or vapor enclosure and that appropriate personal 
protective equipment (PPE) is used in accordance with com-
pany’s chemical hygiene protocols.

DANGER
Hot Surface 
The column oven is able to reach temperatures 
up to 70 °C.  Areas near the heating element at the 
bottom of the drawer may be hotter. 
 
Open the top door of the oven drawer carefully to 
allow hot air to vent. Columns can be hot to the 
touch and should be changed only after they cool.
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Hazards Unique to SFC: 
Using Carbon Dioxide

The ACCQPrep SFC system is designed to perform supercritical 
fluid chromatography using carbon dioxide (CO2) as the super-
critical fluid. The use of other supercritical fluids is prohibited.
Your CO2 gas supplier should be consulted for proper design, 
installation, and safety guidance regarding CO2 supply infra-
structure.
The use of supercritical fluids brings risks that are beyond that 
typical of traditional HPLC or flash chromatography techniques. 
Carbon dioxide as a gas is colorless, odorless, and tasteless. 
While CO2 offers several advantages in safety being non-toxic 
and non-flammable, it does present the risk of asphyxiation. 
Typical concentrations of CO2 in a room can vary between 350 
and 1,000 ppm. As levels rise above 2,000–5,000 ppm, they can 
create health problems like headache, sweating, rapid breathing, 
increased heart rate, shortness of breath, dizziness, visual dis-
turbances, or shaking. NIOSH recommended exposure limit 
(REL) is 5,000 ppm time-weighted average (TWA) over a 10-hour 
period; while NIOSH REL for short-term exposure is 30,000 ppm 
TWA over any 15-minute period. Higher concentrations (above 
100,000 ppm) can result in unconsciousness or death.1

The pressure of a CO2 cylinder is about 860 psi at room tem-
perature. A typical CO2 cylinder stores approximately 50 lbs. of 
liquid CO2. One kg of liquid CO2 expands to around 535 L of CO2
gas at atmospheric pressure. In the case of a cylinder or tank 
rupturing or releasing into an enclosed space, the room can 
quickly fill with CO2 and either poison an individual or displace 
all the oxygen available for breathing. 

DANGER
Risk of Frostbite 
If carbon dioxide leaks from the system tubing or 
fitting, dry ice may form, which may cause 
frostbite if touched. Should leakage occur, stop 
the pumps and take appropriate action after the 
dry ice dissipates.

1. https://www.cdc.gov/niosh/npg/npgd0103.html 
https://www.osha.gov/chemicaldata/183
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WARNINGWARNING
Pressurized Gas 
It is the customer’s responsibility to ensure that the 
ACCQPrep SFC and any CO2 supply and/or connections are 
placed in an appropriately sized room and well-ventilated 
space. 
 
CO2 is denser than air and can accumulate in higher 
concentrations in low spaces. 
 
CO2 monitors should be installed in rooms where the 
ACCQPrep SFC system is installed and any other areas that 
house CO2 supply cylinders or tanks with an alert function 
in case the measured CO2 level exceeds 5,000 ppm. 
 
The system and any CO2 supply lines to the instrument may 
be is pressurized, even after power shut-off. Venting of 
pressurized gases and solvent is possible. 
 
Keep CO2 systems gas-tight. Seal any leaks immediately. 
 
Since some CO2 remains in the eluate stream that either 
goes to the fraction collector, AutoSampler, or to waste 
after the gas-liquid separator, fractions should be collected 
into: 
 
1) open test tubes or bottles using the AutoSampler 
(enclosed in either a vapor enclosure vented to an 
appropriate exhaust source or fume hood); 
2) bottles with a GL-45 thread using the modified GL-45 
bottle caps provided with the system using the fraction 
collection valve with the bottles vented to an appropriate 
exhaust source or enclosed in either a vapor enclosure 
vented to an appropriate exhaust source or fume hood. 
 
Additionally, waste streams from the fraction collection 
valve and/or the AutoSampler should be directed into an 
appropriate waste container that is non-glass, non-sealed, 
and vented to an appropriate exhaust source, or enclosed 
in either a vapor enclosure or fume hood vented to an 
appropriate exhaust source.
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WARNINGWARNING
Aerosolization 
Depressurization of CO2 from the eluate during fraction 
collection may result in aerosolization of 
compounds/sample or solvent found in the eluate.  Do not 
inhale aerosolized particles and observe safety data sheets 
for all substances being used. 
 
The ACCQPrep SFC system should be properly exhausted 
to a suitable exhaust source and the AutoSampler or 
fraction collection bottles should be used in an 
appropriately exhausted fume cabinet, hood, or vapor 
enclosure.

Note
The ACCQPrep SFC has an automatic solenoid shut-off valve 
for the CO2 inlet supply with a redundant closed state when 
not powered. Shutting off the system or removing power to it 
will result in the valve shutting off in an emergency. This valve 
may malfunction if blocked with particle from a contaminated 
CO2 source. Follow installation guide instructions and ensure 
the CO2 supply is filtered before entering the instrument. Have 
a back-up shut-off valve near the instrument.

Electrical Hazards: Electrostatic Discharge
Maintaining the System to 
Prevent Static Electrostatic 
Discharge

Clean the collection tube racks and tray monthly. They are made 
of conductive plastic that must be kept clean to dissipate static 
electricity. Use distilled water with a mild detergent. For tougher 
stains, use isopropyl alcohol.

Preventing Person-to-System 
Electrostatic Discharge

Observe the following precautions to prevent person-to-system 
electrical static discharges:

1. Wear anti-static clothing and shoes when operating the 
system. Stand on an anti-static floor mat.

2. Touch a grounded object before touching the system or 
before handling any of its parts (such as columns). For 
example, metal water pipes are typically grounded. This 
will discharge any static electricity you may have accumu-
lated.

3. Maintain humidity above 65% at the instrument location 
so that static buildup will be generated less readily.
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Preventing Static 
Electrostatic Discharge 
During System Operation

Static electricity can also be generated during system operation, 
such as when non-polar liquids flow through it. To prevent static 
buildup as the system operates, observe the following precau-
tions: 

1. Do not exceed the flow rate specified in the documentation 
for the preparative chromatography column.

2. Prevent air bubbles from accumulating in the flow lines. 
These can significantly increase electrostatic charge.

CAUTION
Static Electricity 
Do not modify any of the tubing/fittings used on or within the 
system. System tubing/fittings is designed to meet specific 
pressure requirements. 
 
When using the ACCQPrep SFC preparative chromatography 
system, take precautions to avoid static electricity buildup. Dis-
charges of static electricity could ignite vapors, especially 
when using the system with flammable, non-conducting sol-
vents operating under high flow rate conditions. 
 
Read, understand, and follow all local and national codes and 
regulations to avoid static electricity hazards.

WARNINGWARNING
Substitution of Tubing 
Never substitute the black tubing on ACCQPrep SFC 
systems. The black tubing (P/N 023-0503-06) is anti-static. 
This tubing is required to dissipate static electricity. 
Discharges of static electricity could ignite vapors.

WARNINGWARNING
Solvent Leaks and Spills 
Do not wipe solvents from system or column surfaces while 
the system is operating or while it is plugged in. 
 
In the event of such solvent leaks, immediately turn off the 
system and disconnect the power cord. The combination 
power switch and circuit breaker is located on the rear 
panel. 
 
In event of column leakage, allow all solvent vapor to 
dissipate before removing the column. Failure to do so 
could cause a discharge of static electricity that could 
ignite vapors. 
 
Have plans in place that conform to local regulations to 
address solvent spills or leakage at your site.
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Electrical Hazards: General

WARNINGWARNING
Placing the System 
Do not locate this instrument near potential spark sources 
such as equipment with mechanical thermostats or line 
level power switches. Vapors that occur during normal 
operation due to open fraction collection vials may be 
ignited by external spark sources.

WARNINGWARNING
Resetting of GFI Devices and Circuit Breakers 
If the lab power outlet circuit breaker or GFI (Ground Fault 
Interrupter) is tripped, follow your company’s procedures 
to ensure no hazardous conditions occur, such as an 
electrical spark igniting solvent vapors in the area. 
 
If the rear panel circuit breaker is tripped, the area should 
be cleared of solvents and vapors before resetting the 
circuit breaker. If the breaker trips again, follow your 
company’s guidance on lock out/tag out to prevent 
operation until the instrument can be repaired by a qualified 
service technician.

For Additional Information Technical assistance for the Teledyne LABS ACCQPrep SFC can 
be obtained from:

Teledyne ISCO 
4700 Superior St. 
Lincoln NE 68504

Phone:  (800) 775-2965 or (402) 464-0231 
Fax:  (402) 465-3001 
E-mail:  IscoService@teledyne.com
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1-1EAR99 Technology Subject to Restrictions Contained on the Cover Page

ACCQPrep® SFC

Section 1  Introduction 

1.1 Overview This Operation Guide provides the following information:
• safety information 
• instrument configuration options, including network 

configuration options
• operating instructions, including information on 

methods, separation, and fraction collection
• an overview of the PeakTrak® interface
• maintenance instructions

1.2 Product Overview The Teledyne LABS ACCQPrep SFC chromatography system 
combines high resolution and productivity in a small footprint. It 
features easy-to-use software, programmable gradients, UV 
detection and peak collection, and automatic detection of col-
lection tube racks. Its small size makes it a great personal 
system and well-suited for operation within chemical hoods and 
other limited indoor spaces. The extended pressure capability 
supports operation of columns at high flow rates for maximum 
throughput or added tolerance for high back pressures as 
columns age.
The ACCQPrep SFC is configured to meet your needs. The 
Solvent Selector Valve supports up to four different choices for 
the co-solvent. Detection options include UV and UV/Vis., ELSD 
and a PurIon mass spectrometer capable of detecting your com-
pounds with up to six individual mass signals, including a range 
of masses. Automation options include the AutoInjector, the 
AutoSampler, and the Column Selector modules.

AutoInjector Module The AutoInjector is an optional module for the ACCQPrep-
system. The AutoInjector module is necessary for stacked injec-
tions. When installed, it performs automated, repetitive 
compound injections completely unattended. This allows you to 
automatically purify larger amounts of compound than can be 
purified with a single separation run, increasing productivity. 
And, when the optional column switcher and solvent switching 
valves are installed, you can test different chromatographic con-
ditions for a single sample. Following PeakTrak’s on-screen 
instructions for the AutoInjector eliminates carry-over between 
samples.

AutoSampler Module The AutoSampler is an optional module for the ACCQPrep 
system. When installed, it automates purification when you have 
several different samples that require multiple injections and 
different chromatographic conditions. It can be used unattended: 
it moves its probe robotically and automatically washes it 
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between samples to eliminate carry-over. The AutoSampler uses 
RFID rack swapping technology to allow you to replace com-
pleted racks.

Column Selector Module The Column Selector module supports up to four Prep SFC 
columns ranging from 20 mm up to 50 mm inner diameter. 
(Larger columns may be used at less than optimum flow rates.) 
PeakTrak software operates the module's column selector valve.
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Figure 1-1 ACCQPrep SFC

ACCQPrep SFC – This Prep SFC system has flow rates from 
50–200 mL/min, with up to 6000 psi (413 Bar) capability. An 
integrated mass-flow meter allows for reproducible chromatog-
raphy every day. A two component gradient can be formed 
between CO2 and 4 different cosolvents. The system includes 
active solvent level sensing and detection of a full waste con-
tainer. The base system includes an 8-port fractionation valve. 
Two different AutoSampler options allow open-bed fraction col-
lection into either two or four collection racks. The RFID tagged 
racks can be replaced while in operation with new racks for prac-
tically limitless fraction collection.
ACCQPrep SFC with optional ELSD  – This system has the 
same high performance features as the ACCQPrep SFC system 
but also includes an internal evaporative light scattering 
detector (ELSD). During operation, this detector can be com-
bined with the UV (200–400 nm) or UV-vis (200–800 nm) 
detection to isolate visible and UV absorbing compounds as well 
as compounds with little or no chromophores.
ACCQPrep  SFC with  optional  PurIon Mass 
Spectrometer  – This system has the same features as the 
ACCQPrep SFC but also includes a mass spectrometer with a 
detection range of 10 to 1200 Daltons (Da) (PurIon S) or 
10–2000 Da (PurIon L systems). During purification, this system 
can be combined with the UV (200–400 nm) or UV-Vis 
(200–800 nm) detector to isolate visible and UV absorbing com-
pounds as well as compounds with specific molecular weights or 
mass ranges. 
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1.3 Operating Overview The ACCQPrep SFC system is equipped with a capacitive touch-
screen display for local control.
The system also supports TCP/IP communication. This protocol 
allows direct control of the system by an external computer 
between Ethernet ports of the ACCQPrep SFC system and the 
computer. 
TCP/IP communication also allows remote control of the system 
via an established network. Remotely controlling devices on the 
network can be Windows or Apple personal computers and
laptops or Apple iOS mobile devices (iPod Touch, iPhone, and 
iPad).

Note
Teledyne recommends that you obtain assistance from your 
Information Technology department before attempting direct or 
network connections. See Technical Note 28 Networking 
Guidelines on the Teledyne LABS website for more information. 

1.3.1 Multiple Control 
Possibilities

The ACCQPrep SFC system can be accessed from the built-in 
touch panel or, alternatively, by using a mouse connected to one 
of its USB ports. Additionally, it can be accessed by up to ten 
network devices. The system performs the most recent command 
from any control input.

1.3.2 File Storage To support operation from a variety of direct and network con-
nect ions,  the sof tware  and al l  f i les  are  stored in  the 
ACCQPrep SFC system. This ensures that your compound purifi-
cation methods and run history files can be viewed from any con-
nection. Optionally, run files may be saved to a USB flash drive, 
a networked controlling computer, or a network drive.

1.4 Safety Components Before installing, operating, or maintaining this equipment, it is 
imperative that all hazards and preventive measures are fully 
understood. Refer to the Safety Overview section at the front of 
this operation guide for general safety information. 
Also, refer to the document ACCQPrep SFC Important Infor-
mation, (PN 69-5263-088) for the most current safety infor-
mation. This document is included with your ACCQPrep system, 
and the latest version is available at www.teledynelabs.com.

1.4.1 Power disconnects The back panel power cords are safety disconnects for the 
ACCQPrep SFC system. There are two: one on the control box 
(Figure 1-2) and one on the oven module. 
To remove power from the system, remove both power cords by 
pulling them straight out from their power inlet connectors. 
Additionally, circuit breaker rocker switches are located adjacent 
to the power inlet connectors. Pressing the end of a switch 
labeled “O” will remove power from that module’s internal oper-
ating components. If an internal circuit fault occurs, a breaker 
will trip. It can be reset pressing the end of the switch to the “|” 
position. 
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Figure 1-2 Location of the control box power cord and 
breaker

1.4.2 System Pressure 
Management

The ACCQPrep SFC monitors the pressure at several different 
points within the system. In addition to predefined pressure 
limits within the system, the user may input a lower column 
pressure limit in order to use and prevent damage to columns 
with lower than system-defined limits.
The ACCQPrep SFC system has redundant safety devices to 
limit system pressure, the maximum system pressure is the 
lowest of these two values:

• 6,000 psi (412 bar) maximum system pressure; or
• the maximum pressure of the column as defined by the 

user in the Prep SFC Configuration.
Overpressure Conditions Exceeding the system pressure limit results in a hard stop of the 

system.
The system pressure limit is a dynamic value based upon 
the column PRESSURE LIMIT + measured BPR PRESSURE.
The Pressure Gauge above the Gradient Plot area of the MAIN 
screen (Section 4.3.1) reports the system pressure, the measured 
BPR pressure, and the actual system pressure limit.
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1.5 Specifications 

Table 1-1  ACCQPrep SFC

Dimensions of ACCQPrep SFC 
(Footprint without column installed)

41 x 56 x 73 cm (16.25 x 22.25 x 28.75 in) (W x D x H)

Weight
(Including AutoInjector, Column Selector 
Valve Module, Pump Module, Column Oven, 
and Control Module)

83.3 kg (183.5 lbs)
89.0 kg (196.3 lbs) with optional Evaporative Light Scattering Detec-
tor (ELSD)

Dimensions of ACCQPrep SFC 
AutoSampler AS 2x2

34 x 56 x 66 cm (13.5 X 22.25 X 26 in) (W x D x H)

Weight of ACCQPrep AutoSampler AS 2x2 14.1 kg (31.1 lbs)

Dimensions of ACCQPrep SFC 
AutoSampler AS 4x2

58 x 56 x 66 cm (23 x 22.25 X 26 in) (W x D x H)

Weight of ACCQPrep AutoSampler AS 4x2 19.1 kg (42.2 lbs)

User Interface 15" high-resolution touchscreen

Power Input voltage range: 120(+-10%) or 240 (+-10%) VAC; 
300 VA maximum.
Line cord is the disconnect device. Power connection is via IEC 
60320 C14 power inlet.

Line Frequency 50/60 Hz

Ambient Temperature 20 to 40 °C (maximum temperature must be at least 15 °C below the 
boiling point of the solvent) 
(Environmental requirements for any optional modules are the same 
as those for the ACCQPrep SFC system, except that the CO2 chiller 
has a ambient temperature range of 5° to 35 °C (41° to 95 °F); and 
relative humidity maximum of 80%, noncondensing)

Humidity (when connected to power) 90% relative humidity maximum at 20 to 40 °C (non-condensing)

Altitude 2000 m (6561 feet) maximum

Flow Rate Range (system) 50–200 mL/min

Flow Rate Accuracy ± 2%

System Pressure Limit 414 bar (6000 psi). The system pressure limit is the combination of 
the column pressure limit and the back pressure regulator (BPR) set-
ting.

Pressure Accuracy 5% of full scale

Gradient Formation Binary gradient 4 solvent inlets. 

Gradient Accuracy: ±1% of full scale (typical) 

Peak Detection Modes Slope or threshold

Flow Cell Pathlength 0.5 mm, ±25% (Standard)

UV Detection Wavelength Variable UV PDA (200-400 nm) or 
Variable UV-VIs PDA (200-800 nm)

UV Lamp Source Deuterium

Wavelength Accuracy ±5 nm 
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Optional ELSD 
Gas Inlet Pressure 60 to 70 psig 

Gas Consumption <2.5 SLPM

Drift Tube Temperature Setting range: 30 to 90 °C
Minimum temperature is 5 °C above ambient 
Maximum temperature is 60 °C above ambient

Electrical Safety per EN 61010-1
Pollution Degree 2

Installation Category II

Maximum Altitude 2000 meters

Note 1. All specifications are subject to change.

Table 1-1  ACCQPrep SFC

Table 1-2  ACCQPrep SFC with PurIon System

Dimensions (H x W x D) ACCQPrep: 27.5 x 14.0 x 20.0 in (69.9 x 35.6 x 50.8 cm)
Mass Spectrometer 26 x 11 x 22 in (66 x 28 x 56 cm)
Roughing Pump 10 x 9 x 18 in (26 x 23 x 46 cm)

ELSD Detection Option that can be combined with either UV or UV-Vis

Mass Spectrometry Detection
10 – 1200 Dalton for S model, 10-2000 for L model,  
1 Dalton Resolution

Electrospray Ionization (ESI) or optional Atmospheric Pressure 
Chemical Ionization (APCI)

Positive or negative ionization for both S and L models.

Note 1. All specifications are subject to change.

Table 1-3  Component Materials List

Chromatographic Tubing 316 stainless steel tubing, PEEK, and 
Fluoropolymer

Drain Tubing Vinyl with FEP liner

Chromatographic Valves PEEK, PPS, perfluorelastomer (FFKM)

Flow Cell PEEK, quartz, FEP

Chromatography Pump 316 Stainless Steel, UHMWPE, ETFE, ruby, sapphire, and zirconia

Pressure Transducer 316 and 17-4 PH stainless steels and perfluorelastomer (FFKM)

AutoSampler Wash Pharm-A-Linepolypropylene 
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1.6 FCC Statement ACCQPrep SFC systems with AutoSamplers are equipped 
with RFID rack recognition and contain modules with 
FCC  ID  number  2ADZB ID- 2 a nd  are  subject  t o  the 
following statements:

1. This device complies with Part 15 of the FCC Rules. 
Operation is subject to the following two conditions:
a. This device may not cause harmful interference.
b. This device must accept any interference received, 

including interference that may cause undesired 
operation.

2. Changes or modifications not expressly approved by the 
party responsible for compliance could void the user’s 
authority to operate the equipment.
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ACCQPrep® SFC

Section 2  Configuration

2.1 Configuration of the 
ACCQPrep SFC

The system can be configured using PeakTrak. For more about 
the user interface, see Section 4, PeakTrak.

2.2 Turning the System On 
and Off

For power control, ACCQPrep SFC systems use a combination 
power switch and circuit breaker located on the rear panel of the 
control module and rear panel of the oven module.
For normal operation, the switch can be left on while the right 
side panel RUN/STANDBY push button is used to control most 
power circuits within the instrument. Power consumption while 
in Standby is about 6 W.
Use of the rear panel power switch basis is also acceptable. If 
used for power control, the system should be placed in Standby 
until the screen goes dark before switching the back panel power 
switch off to allow the internal operating system to complete an 
orderly shutdown.

CAUTION
Do NOT turn ON the main power of the AutoSampler while the 
ACCQPrep SFC is turned ON. 
Ensure that the AutoSampler is turned on before the 
ACCQPrep SFC unit in order to avoid damage to the system.

Note
The rear panel mounted circuit breaker is the power discon-
nect device.
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2.3 Instrument 
Configuration 

Instrument Configuration (Figure 2-1) can be found at TOOLS > 
CONFIGURATION > the INSTRUMENT CONFIGURATION tab.

Figure 2-1 The Instrument Configuration tab

Note
You can back up and restore instrument settings and data 
using Help > Backup / Restore (Section 4.2.6)
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From the INSTRUMENT CONFIGURATION tab, you can select the 
cosolvents.

• ADD SOLVENT and REMOVE SOLVENT edit the list. If you 
do not see your solvent name on the list, select ADD 
SOLVENT and type in the solvent name. Select REMOVE 
SOLVENT to remove solvent names that you no longer 
use.

Note
The physical properties of each cosolvent require unique sys-
tem settings for each cosolvent to ensure proper system per-
formance, including peak cutting and fraction collection. 
 
PeakTrak software automatically sets and compensates sev-
eral system settings, depending on the chosen cosolvent. For 
proper system performance it is imperative that the proper 
cosolvent is chosen. 
 
If a solvent you intend to use is not on the current solvent list, 
contact Teledyne LABS for guidance.

Solvent Levels – 
• MINIMUM SOLVENT LEVEL allows you to specify a 

minimum level in centimeters.
• ENABLE SOLVENT LEVEL SENSING monitors the solvent 

level in each of the supply containers. If Solvent Level 
Sensing is enabled, the CO2 inlet supply pressure is also 
monitored to notify the user that a low CO2 supply 
condition is possible.

• ENABLE WASTE LEVEL SENSING stops the system when 
the waste level reaches approximately 1" (2.54 cm) 
above the sensing line.

CAUTION
If ENABLE WASTE LEVEL SENSING is unchecked, the waste col-
lection container could overflow.

System – 
• ACCQPREP NAME— Names the ACCQPrep SFC system. 

At sites where multiple systems are in use, entering a 
name tells users which system a printed report came 
from.

Setting Time Zones and Date/Time – 
• TIME ZONE — Sets the system to your time zone. The 

choice made here automatically changes the time during 
daylight savings time.

• SET DATE/TIME — Sets the system to your local day and 
current time. If an administrator password is set, 
setting the date and time will be required. All separa-
tions are tagged with the date and time of operation. If 
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the sample was not named previously, the date and time 
will be used as its identifier. Therefore, the system time 
provides a way of identifying samples.

Vapor Sensitivity – The ACCQPrep  SFC sys tem has an 
internal vapor sensor in each of the system modules to detect 
organic vapors inside the system. The sensor is intended to 
monitor the system for leaks of internal plumbing connections. 
Fluid vapors external to the system may be detected when 
ambient air is drawn into the systems by the cooling fans. When 
the vapor level limit is exceeded, the system will stop the pumps 
to minimize a hazardous condition.
Currently, Teledyne LABS ships all systems with this vapor 
limit feature enabled to the default setting of HIGH sensitivity.
Sensitivity settings and the approximate percentage relative to 
the lower explosive limit (LEL) of hexane are provided in the 
table below.

Vapor sensor alerts from the oven module may occur when 
removing or installing columns or may be due to loose fittings. 
Alerts from other system modules or repetitive alarms from the 
oven module may indicate an internal leak to the system 
requiring evaluation from a qualified service engineer.
High sensitivity settings may result in false alarms (i.e., without 
an internal leak in the system) when the ambient vapor level in 
the area is high. If PeakTrak displays a vapor limit alarm (shown 
below), perform the following checks on your laboratory and on 
the instrument:

• Ensure that no open containers or spills of organic 
solvent are in close proximity to the system.

• Ensure that the system is located in a well-ventilated 
area.

• Ensure that there is no visible solvent leakage from the 
system.

Table 2-1  Vapor Limits

Sensitivity 
Setting

Percentage 
(relative to the LEL 
of hexane)

Low 45%

High 5%
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Figure 2-2 PeakTrak vapor limit alarm

After you have remedied the cause for the vapor sensor alarm, 
you may choose to change the default vapor sensitivity level, or 
ignore the vapor alarm and continue operation without the vapor 
sensor disabled for 10 minutes.
If PeakTrak continues to display the Vapor Limit alarm after you 
have made these checks and corrected any problems found, it is 
likely that excessive organic vapors are present in the ambient 
environment of your laboratory, or the laboratory has higher 
ambient humidity and/or temperature conditions. In such cases, 
choosing a lower sensitivity Vapor Limit setting is possible. Low 
sensitivity settings are appropriate for laboratory environments 
with a somewhat elevated background solvent vapor concen-
tration. By changing the Vapor Limit sensitivity level, you 
assume any additional risk and reponsibility for taking any addi-
tional steps to mitigate the increased risk of disabling or low-
ering the vapor limit sensitivity level.
If you start a run when VAPOR SENSITIVITY is set to Disabled, the 
MINIMUM RUN REQUIREMENTS window will warn you of that fact.
Queue Screen Custom Parameters – A  custom co l um n 
option. The parameter chosen here displays as a column on the 
QUEUE tab of the MAIN screen.
Set Default Tube Volume – Determines how much is collected 
in each test tube. A suggested amount is preset, but if you prefer
another level of fluid in each test tube, you can enter the tube 
volume you would like to use. This becomes the default volume 
used for new methods, but that can be changed within the 
METHOD EDITOR. PeakTrak automatically tracks the total liquid 
volume (cosolvent and make up flow) collected in each fraction 
vessel or test tube. Be sure to leave sufficient height in the vessel 
or tube for the z-axis fraction collector probe to direct fluid flow to 
the wall of the vessel without splattering.

Note
PeakTrak automatically accounts for the amount of CO2 that is 
part of the eluate and compensates so that it is only tracking 
the liquid volume.
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Enable Oven Heater – Enables the column heater. Useful 
when tight temperature control is desired. The heater should be 
enabled for consistent retention times.
Queue Screen Custom Parameters – This sets extra param-
eters for the QUEUE tab (Section 3.3.4). These parameters change 
fraction collection options:

• None (no additional parameters)
• UV Threshold – level, as absorbance units (AU), to start 

peak collection
• Detection Ions – The ions used for peak collection 

(PurIon equipped systems only)

2.4 Network 
Configuration

Network Configuration –  
Settings to connect the system to a network can be found 
under TOOLS > CONFIGURATION > the NETWORK 
CONFIGURATION tab.

Figure 2-3 The Network Configuration tab

Once the system is connected to a network, you can 
remotely view the PeakTrak user interface to monitor or 
control the system, print to a network printer, or 
automatically save data files right to the network. 

To connect to a network, you need access to IP addresses and 
network information from your Information Technology (IT) 
department. Contact your IT department before changing 
these settings. For more information on Network 
Configuration, see Technical Note 28, available at 
www.teledynelabs.com.

Instrument IP Address Configuration – 
Specifies the instrument’s network address and its parameters:



ACCQPrep® SFC 
Section 2   Configuration

2-7EAR99 Technology Subject to Restrictions Contained on the Cover Page

• NETWORK TYPE – 
· Static IP: Requires an IP address, Netmask, and 

Gateway provided by your network administrator.
· DHCP: Automatically retrieves the IP address, 

Netmask, and Gateway from the DHCP server.
• IP ADDRESS – The static IP Address for the system. This 

applies only when the NETWORK TYPE is STATIC IP.
• NETMASK – The Netmask for the system. This applies 

only when the NETWORK TYPE is STATIC IP.
• GATEWAY – The Gateway for the system. This applies 

only when the NETWORK TYPE is STATIC IP.
Network Printing – Configures the system for use with a 

network printer. JetDirect and line printer (LPR) queues 
are supported. Consult with your network administrator to 
determine printer information:

• The IP address of selected printer.
• The queue name, if the printer uses an LPR print queue.
• The port number, if the printer uses a JetDirect print 

queue.
• The printer type (either PostScript or PCL).

When this information is known, you can proceed with 
configuring system for network printing. Follow the 
on-screen instructions for entering the CONNECTION URL 
and PRINTER TYPE information. After successfully printing 
a test page, the network printer will be available for 
printing using FILE > PRINT and the AUTOMATICALLY PRINT 
AT END OF RUN feature.

Network File Save Configuration  – When configured, 
allows the system to access a network directory from which 
it can save run files as PDF, Text, PDF and Text, or Run 
Monitor. To enable this feature, select a file type to be saved 
and enter the remaining settings required for network 
access. Your network administrator can provide these 
settings.

Note
All server and domain names must be fully qualified. That is, 
entries must include the full name 
(server name.domain.domain…). Use forward slashes (/), not 
back slashes, when entering the network share path.

2.5 User Preferences Options for each user are found under TOOLS > CONFIGURATION >
the USER PREFERENCES tab. The user for whom the settings will 
be made is listed at the top of the tab.

Note
You can back up and restore instrument settings and data 
using Help > Backup / Restore (Section 4.2.6).
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Figure 2-4 The User Preferences tab (detail)

Language  – Allows selection from several languages for the 
user interface. If the system is set up for multiple users, 
each user can select a preferred language.

Pressure Units – Allows you to choose between PSI and Bar.
Other User Preferences – 

• AUTOMATICALLY PRINT REPORT — Prints a report at the 
end of a run if the system is connected to a network.

• GRAPH SYSTEM PRESSURE — Shows the system pressure 
during a separation. This information is useful for 
troubleshooting a system that does not operate as 
expected. 
 
For normal operation, selecting GRAPH is not recom-
mended. This information is always stored with the run 
data for later review, so if a problem is suspected, this 
parameter can be enabled and the suspect separation 
opened to review the pressure profile during the 
separation. 
 
The pressure trace doesn’t have a vertical scale with 
pressure. To view the actual pressure at a point in time, 
refer to the status bar in the upper right corner of the 
screen during a separation. If you are reviewing a previous 
separation, this information isn’t available on the screen, 
but the profile of the trace is often adequate for trouble-
shooting. 

• SHOW ABSORBANCE DURING EQUILIBRATION — Shows 
absorbance of the system during equilibration to verify 
baseline stability.

• WASH FRACTIONATION VALVE TUBING BY DEFAULT — 
Makes a fractionation valve line wash the default for all 
runs that use the fractionation valve. It works by 
checking FLUSH FRACTIONATION VALVE TUBING AFTER 
SEPARATION by default on the COLLECTION DEFINITION 
window for each run, which directs the system to wash 
tubing after that separation. However, the wash step 
can still be turned off when starting an individual run 
by unchecking FLUSH FRACTIONATION VALVE.
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See Section 3.4.1  SFC Fractionation Valve Line Wash for 
more information about the wash process.

Note
If a PurIon mass spectrometer detector is attached, you can 
set the DEFAULT MS GRAPH settings. The X-AXIS START con-
trol denotes the starting mass displayed in the mass spectrum 
graph. The X-AXIS END control denotes the ending mass dis-
played in the mass spectrum graph. In either case, the entire 
mass spectrum (10 Da through 1200 (2000 Da PURION L 
only)) is always acquired and stored and can be viewed later 
opening the format graph button on the results screen. 

2.6 Prep SFC Options to define and configure SFC columns and methods can 
be found under TOOLS > CONFIGURATION > the PREP SFC tab.

Note
You can back up and restore instrument settings and data 
using Help > Backup / Restore (Section 4.2.6).

Figure 2-5 The Prep SFC tab

Loop Volume – The ACCQPrep SFC system ships with a 
preinstalled 5 mL sample loop and a 1 mL loop (found in the 
accessory fittings package case). The installed loop volume 
is used for several calculations within the software, 
including for the Focus Gradient Generator tool. The 1 mL 
loop provides better injection accuracy and reproducibility 
when doing injections below 0.5 mL. Injections larger than 
this can effectively be done using the 5 mL loop. 
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If loops are changed on the system, it is important to update 
the LOOP VOLUME value to ensure that the system can 
identify any potential issues between the proposed injection 
volume and the size of the sample loop on the system.

• A warning is displayed if the injection volume inputted 
may exceed the sample loop capacity and sample is at 
risk of being lost through the injector.

• The system, however, does not limit the injection 
amount that can be programmed. This warning can be 
ignored at your discretion. 

Column Position 1, 2, etc. – Maps a column to a specific 
position on the column selection valve.

• Each number matches a column definition to a corre-
sponding column position in the ACCQPrep SFC system 
as indicated by the labels on the lines that connect the 
columns. Defining these columns is described in Section 
2.6.5  Defining a Column.

• Only defined columns are shown on the MAIN screen, 
where runs are started. If a column position is not 
plumbed, define the position as NOT INSTALLED to 
prevent accidental use of the position is advised.

2.6.1 Installing a Loop Installing a loop is similar to installing a column (Section 2.6.4); 
however, you need a 1/4" wrench to connect the loop directly to 
the injection valve in the back of the oven box drawer.

Figure 2-6 The sample injection valve

2.6.2 Removing a Column 
from the System

Ensure that the column is stored under appropriate solvent 
storage conditions, as described by the column manufacturer.

1. Open TOOLS > MANUAL CONTROL.
a. If the pumps are running, select STOP FLOW. (If the 

pumps aren't currently running, this button will not be 
visible.)

b. Select the column position you wish to replace.
c. Vent system pressure.

2. Open the oven box drawer.
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3. Gently loosen the outlet fitting on the column (or union) to 
release any pressure still on the column.

CAUTION
Flowpath Under Pressure
Before removing any component in the high-pressure flowline, 
such as tubing, the sample loop, in-line filter, column, etc. stop 
the pump and confirm the system pressure has fallen to zero. 
Depending on the position in the flow path, the system may 
need to be vented via Manual Control to release the pressure 
completely. Removing any of these parts while high pressure 
remains could cause the mobile phase and the clogging parti-
cles to eject rapidly and injury could occur.

4. After the column pressure is fully relieved from the outlet, 
the inlet fitting may be removed.

5. Connect the tubing from the column selection valve via a 
union.

2.6.3 Priming the Cosolvent 
Pump

Be sure that the cosolvent pump is properly primed before use, 
after changing or refilling solvents, and when directed. Oth-
erwise, CO2 can accumulate in the cosolvent fluid path and enter 
the sample injection flow path, which could lead to sample loss.

1. Make sure that adequate amounts of the desired 
cosolvents for priming are available to the solvent inlet 
lines.

2. Turn the manual prime valve control (Figure 2-7) to PRIME. 
The control is located to the right at the front of the pump 
module. This opens a PeakTrak solvent priming options 
window automatically (Figure 2-8).

Figure 2-7 The manual prime valve control
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Figure 2-8 The PeakTrak solvent priming options window

3. Using the dropdown lists on the PeakTrak window, choose 
solvents for the priming process.
· Solvents are run sequentially starting with the 1ST 

SOLVENT in the list and proceeding to the 2ND, etc.
· The NEW SOLVENT name is the solvent that will run 

when priming with the corresponding solvent in the 
left-side list is complete.

· Choose the last solvent that you plan to use for your 
next separation as the last solvent in the list.

· Make sure that the solvents are input in an order in 
which they will be miscible.

4. Select OK. The system primes with the list of solvents 
entered.
· A window that reports the expected completion time 

of the priming run in seconds appears for each 
solvent’s priming cycle.

· A “priming complete” window announces the 
completion of the priming process.

5. Turn the manual prime valve control to RUN.

2.6.4 Loading a Column 
onto the System

Note
Follow column manufacturer guidelines for removal of columns 
and column storage conditions.

The COLUMN POSITION numbers on the CONFIGURATION window 
correspond to column positions in the ACCQPrep SFC system, as 
indicated by the labels on the lines that connect the columns.
To connect a column to the system:

1. Open TOOLS > MANUAL CONTROL.
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a. If the pumps are running, select STOP FLOW. (If the 
pumps aren't currently running, this button will not be 
visible.)

b. Select the column position you wish to replace.
c. Vent system pressure.

2. Open the oven box drawer.
3. Ensure the column position you want to use is fully vented. 

(Refer to 2.6.2  Removing a Column from the System.)
4. Locate a pair of lines having the same label number for 

both sides of the column. Take note of the number; you will 
need it when you define a column (Section 2.6.5).

5. Connect the lines located in Step 4 to the column. Make 
sure that the column is oriented so that its arrow label 
matches the direction of arrows on the connecting lines. 
One end of each line should be connected to the column. 
The other end of each line should remain connected to the 
column select valve at the rear of the oven drawer.

Figure 2-9 The column select valve

6. While the oven drawer is open, set the flow rate to 
30 mL/min, choose 5% cosolvent, and select 
PUMP 5% COSOLVENT. Monitor the oven box and column 
fittings for any leaks. After you confirm that there are no 
leaks, you may close the oven drawer and use the column.

Configuration > 
PrepSFC (tab) > 
Calibrate External SFC 
(button)

Calibrating an analytical SFC system to the ACCQPrep SFC can 
increase method development efficiency.
To calibrate the external SFC, run universal test mix on both the 
external SFC and the ACCQPrep with matching chemistry 
columns. Refer to Teledyne LABS Chromatography Technical 
Note CHR-TN2410 for that procedure. After the parameters are 
determined, enter them into the ACCQPrep SFC:

1. CONFIGURATION > PREP HPLC Tab > CALIBRATE EXTERNAL 
SFC. The CALIBRATE EXTERNAL SFC window opens (Figure 
2-11).

2. Select ENABLED.
3. Enter settings to calibrate the analytical SFC system to 

the preparative SFC system, then select OK to dismiss the 
CALIBRATE EXTERNAL SFC window.
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4. Select OK to dismiss CONFIGURATION and to reveal the 
MAIN screen.

To use the custom method, you must select it when you select a 
column for a separation:

1. On MAIN, select a COLUMN. When a column is selected, a 
method list appears..

2. Select HPLC FOCUS from the list. The HPLC FOCUS win-
dow opens.

3. Enter the RETENTION TIME from your analytical system.
4. Enter a FOCUS RANGE (+/- 0, 5, 10, or 20%), then select OK.

The Calibrate External 
SFC window

Figure 2-10The Calibrate External SFC window

ENABLED – Provides gradient and calibration options used 
after calibrating an analytical SFC system to the 
preparative SFC; it also displays this option in the column 
method choices.

External SFC options
• GRADIENT INITIAL %B – The starting percentage of B 

solvent.
• GRADIENT FINAL %B – The ending percentage of B 

solvent.
• GRADIENT DURATION – The length of the gradient. It is 

not the total run time.
• CALIBRATION RETENTION TIME – Specifically, the 

retention time of the calibration compound.

ACCQPrep SFC options
• CALIBRATION COMPOUND %B – The %B that causes the 

calibration compound to elute at the correct retention 
time.

• FOCUS RANGE – This is commonly ±5%. 
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2.6.5 Defining a Column Accurate column settings are important to protecting your 
column, as many columns have pressure limits below the system 
pressure limit of the ACCQPrep SFC system. PeakTrak automat-
ically monitors the unique pressure limits of each column to 
prevent damage to columns from over-pressure events.
Additionally, column size and type parameters are important to 
update for the system to work optimally. The calculated column 
volume from these parameters are used in several key features of 
the system, including the Focus Gradient Generator and peak 
alignment.
Follow these steps to define a column:

1. Create a new column:
a. On the MAIN screen, select TOOLS > CONFIGURATION. 

The CONFIGURATION window opens. On the PREP SFC 
tab, select the NEW button next to the COLUMN NAME 
menu. A window opens requesting a column name.

b. Enter a name for the new column into the field. This 
name can describe the column or, for example, it can 
identify it exactly using the column serial number.

2. After the name is entered, select ENTER.
3. To complete the column definition, enter the MEDIA SIZE 

and column dimensions.
4. Select the INSIDE DIAMETER of the column. A flow rate for a 

default method is selected on the basis of the scaled-up lin-
ear velocity of a 4.6 mL analytical column running at 
1 mL/min.

5. Select the LENGTH of the column. This provides the sug-
gested default method for the gradient portion of the sepa-
ration, along with an initial isocratic portion, a strong 
solvent portion to wash the column, and a portion that 
returns the column to a suggested storage fluid concentra-
tion.

6. The PRESSURE LIMIT is set by default to a typical limit for 
preparative SFC columns, but this can be changed for each 
column to a suitable pressure not exceeding the system 
pressure limit of 6000 psi. Refer to literature included with 
the column when entering the PRESSURE LIMIT.

7. SAVE the default method associated with the column.
To customize the method that was just created, select DEFINE 
METHODS followed by EDIT to view and modify all the method 
parameters. Further information can be found in Section 5.2.2.
Once the column definition is created, you can use it by assigning 
it to a column position on this window corresponding to a 
matching installed column; that is, to COLUMN POSITION 1, 
COLUMN POSITION 2, etc.

2.6.6 Resetting Column 
History

If you are replacing a column in a position with an identical 
column, you needn’t create a new column definition, Instead, you 
can reuse the existing one by choosing its COLUMN NAME and 
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selecting RESET COLUMN HISTORY. That history includes the 
number of runs performed with the column and the solvents used 
for those runs.

2.6.7 Deleting a Column To delete a column at CONFIGURATION > PREP HPLC:
1. Make sure that the to-be-deleted-column is not selected in 

a COLUMN POSITION field.
2. Select the column you would like to delete from the COL-

UMN NAME list.
3. Select DELETE.
4. If an error message states the method is currently in use, 

leave the CONFIGURATION window and go the to RUN 
screen. From there, select a different column.

2.6.8 Creating Other 
Methods

Methods created in the PREP SFC tab are associated with a par-
ticular column when created. If multiple methods are asso-
ciated with a single column, these methods can be easily 
accessed whenever a particular column is selected. These 
methods are shown on the MAIN screen and the METHOD EDITOR
in the column selection lists in the order that the methods were 
created. 
Follow these steps to create the new method for a column: 

1. Select TOOLS > CONFIGURATION. The CONFIGURATION win-
dow opens.

2. On the PREP SFC tab, select the COLUMN NAME that you 
want to associate with the new method.

3. Select DEFINE METHODS on the PREP SFC tab (Figure 
2-11). The tab then shows options to define methods for 
your selected column (Figure 2-12).

Figure 2-11The Define Methods button
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Figure 2-12Define Methods options on the Prep SFC tab 
(detail)

4. Select NEW. If you are accessing CONFIGURATION from the 
touchscreen, an on-screen keyboard will open.

5. Enter the name you have chosen. 
6. Select ENTER (touchscreen) or OK (remote computer).
7. The newly created method uses the default method  

parameters. To modify the new method:
a. Select EDIT. 
b. Make changes as needed in the METHOD EDITOR.
c. EXIT when completed.

2.6.9 Creating Scouting and 
Focused Gradients

PeakTrak offers an integrated tool for method optimization 
called the Focus Gradient Generator. This feature runs a 
scouting gradient on your sample to find the ideal focused gra-
dient conditions for your separation. Focused gradients offer a 
quick way to greatly improve resolution around the peaks of 
interest.
To use the Focus Gradient Generator feature, you must first con-
figure your column to use a Scouting Gradient:

1. Select TOOLS > CONFIGURATION. The Configuration win-
dow opens.

2. On the PREP SFC tab, select the COLUMN NAME that you 
want to associate with a scouting gradient (Figure 2-13).
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Figure 2-13Column Configuration

3. Select DEFINE METHODS on the PREP SFC tab. The tab 
then shows options to define methods for your selected col-
umn.

4. Select NEW SCOUTING METHOD. This opens the SCOUTING 
METHOD FOR FOCUSED GRADIENT window (Figure 2-14).

5. Define the FLOW RATE, the INITIAL %B, and the FOCUS 
RANGE, and assign a METHOD NAME to the scouting 
method. This name will then be listed among the methods 
that can be selected to run on the column that you selected.

Figure 2-14Scouting Method definition window

6. After a scouting gradient has been defined, load the col-
umn and the scouting method:
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7. In the MAIN screen, select the column that you want to use 
for the run.

8. Select the scouting method you previously defined for that 
column (Figure 2-15).

Figure 2-15Loading the Scouting method

9. After the column and method are selected, select START.
10. Input your injection parameters as usual, and let the run 

proceed (Figure 2-16).

Figure 2-16A Scouting Run

A RUN window appears upon completion of the run:

column method
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Figure 2-17Run file window at end of run.

11. Define the focused gradient:
a. Select the FOCUS GRADIENT button from the bottom 

right of the Run File window (Figure 2-17). The 
FOCUSED GRADIENT DEFINITION window appears (Fig-
ure 2-18).

Figure 2-18Focused Gradient Definition window

b. Select the peak at which you would like your purifica-
tion to be optimized. Using a finger on the touchscreen, 
you may move the vertical red line designating this 
peak as needed.

c. Select the column for which to generate the optimized 
focused gradient from the list at the bottom of the win-
dow.

d. Select a FOCUS RANGE (±0% to ±20%).
12. Select FOCUS. This generates an optimized method cen-

tered on the selected peak.
A possibility: a dialog warns you that the target compound 
will eluted have too early or too late, so the generated 
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method may not be truly optimal. Possibly, early elution 
could be remedied by using another solvent system or col-
umn. See 3.5  Operation Troubleshooting (Peaks elute too 
early and Peaks elute too late) and the Teledyne’s Technical 
Note Focused Gradients— What Do You Mean the Com-
pound Eluted Too Early or Too Late?! (TN61).

13. When the run is finished, a RUN VIEWER window opens to 
show the focused gradient.
A RUN VIEWER window displaying a previous scouting run 
(4.4.7  Viewing Runs) may also make the FOCUS GRADIENT
button available.

2.7 Idle Configuration Configuration controls are provided to schedule and time oper-
ation of the heaters and the pump. Setting these controls pro-
vides a way to balance convenience with energy and solvent 
savings.

Figure 2-19The Idle Configuration tab

The following options are found under TOOLS > CONFIGURATION 
> the IDLE CONFIGURATION tab:
Heater Control — Heaters can be scheduled to run on 

certain days and at certain times. This allows the heaters to 
be prewarmed in advance while using less energy than 
leaving the heaters on continuously. Without prewarming, 
the heaters could take from several minutes to a half an 
hour to warm up.

• SUNDAY, MONDAY, etc. — Selects days and schedules 
times at which heaters automatically turn on and off. 
The instrument can still be used on days that are not 
selected, but it will then be necessary to wait as the 
heaters warm up.

Pump Control — When the pumps start up, they take time 
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to pressurize the system with CO2 and stabilize the flow. 
Pump Control allows the pumps to remain running after an 
operation is stopped. This provides for immediate use of the 
system, while reducing the use of solvent by limiting how 
long it is pumped. Such operations include performing a 
run, and operating the pumps in manual control.

• PUMP AT PREVIOUS CONDITIONS — Sets the length of 
time the pumps continue to run without any user input 
with the same flow rate and concentration before 
stopping. This results in the fastest start time, since the 
column's condition is left unchanged.

• PUMP REDUCED CO2 AND 1ML/MIN LIQUID — After the 
PUMP AT PREVIOUS CONDITIONS time expires, the PUMP 
REDUCED option allows the system to slow down the 
pump while keeping it running. This changes the 
concentration on the column, but allows running 
without waiting for the pumps to start up. 
 
Choose the flow rate at which the CO2 pump runs and 
the number of minutes this flow rate will be used before 
the pumps are stopped. As noted on the CONFIGURATION 
window, the liquid always pumps at 1 mL/minute in this 
operating mode.
· To pump at the previous rate only, set the PUMP 

REDUCED rate timing 0 minutes.
· To pump at the reduced rate only, set PUMP AT 

PREVIOUS CONDITIONS to 0 minutes, then set the 
PUMP REDUCED rate timing to 1 minute or greater. 

If times greater than 0 minutes are set for both pump options, 
the pump will operate at the previous rate for the specified time 
and then pump at the reduced rate for the specified time.

2.8 Scheduled Operations Scheduled Operations can be found under: TOOLS > CONFIGU-
RATION > SCHEDULED OPERATIONS (Figure 2-3).

Figure 2-20Scheduled Operations
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Here, routine operations can be scheduled to be run as needed. 
For example, you can create entries to

• wash all installed columns at the end of the day to 
remove buffers and modifiers, potentially improving 
column life, and

• periodically run reference standards to test retention 
times and peak shapes.

The operations to be run must be saved to queue files. When 
ENABLE is selected, BROWSE to select a queue file, then select a 
TIME and a day. The TIME must be entered in a 24:00 format. The 
TIME ZONE set in CONFIGURATION (Section 2.3) is used by the 
scheduler.
Entries are added to the active queue and are run after queued 
samples.
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ACCQPrep® SFC

Section 3  Operation 

3.1 Introduction The ACCQPrep SFC system is unique to the chromatography 
market. It provides several methods of operation that you can 
select to fit your needs.
Methods contain all of the information used during a separation 
of a single sample, such as gradient profile, detection and peak 
cutting parameters, and fraction size. Repetitive sample 
injection is programmed as needed and doesn’t require creation 
of a separate file.
One of the unique features of the ACCQPrep SFC system is that 
a defined method file is not required for operation. You can load 
and modify a default or existing method for the current sepa-
ration without needing to save the newly modified method.
In addition, any of the method parameters can be modified during 
the separation. None of these changes affect the original method 
unless you choose to save the changes to the original method. All 
method and injection parameters used for starting the separation 
or modified during the separation are stored with the chromato-
graphic data so that no information is lost. 
In addition, the method and injection parameters used during a 
separation can be extracted from the data file and saved as a 
named method for future reuse.

3.2 Method Selection There is more than one way to select a method:
• Use a pre-programmed column that has predefined 

methods associated with it. After the column is selected, 
select one of the associated methods. This workflow is 
especially convenient if you typically only use a few 
predefined methods.

• Use a method file that has been saved before. Go to 
FILE > OPEN. A FILES selection window opens. Sort for 
the method file (*.pmtd) that fits your needs and select it.

• Extract a method from a previous run. Go to 
FILE > OPEN. A FILES selection window opens. Open the 
run file (*.run) from a previous separation, then select 
EXTRACT on the lower portion of the Run file window.

If the method selected is adequate, select START to continue. If 
the method is not exactly as needed, it can be edited. Edit the 
common parameters of any method by adjusting the points on 
the graph, changing major parameters on the MAIN screen, or by 
selecting the METHOD EDITOR. Once edited, the method can be 
used directly for the immediate separation(s) or saved with a 
name for future reuse.
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3.3 Starting a Separation To separate a single sample, select START to start a separation. 
The MINIMUM RUN REQUIREMENTS and SAMPLE OPTIONS 
windows are displayed. There, you can select an injection tech-
nique (using the AutoSampler or the AutoInjector with the 
external sample loading probe) and select where the fractions 
will be collected (that is, into the fractionation valve or into the 
selected starting rack and tube position on the open-bed fraction 
collector on the AutoSampler module). The system projects the 
amount of solvent required and the separation duration.

Note
It is important to use the supplied external sample loading probe 
or AutoSampler sample probe without modification because the 
system uses the known volumes of these probes in the sample 
loading process to ensure accurate sample injection.

For an ELSD If an ELSD is installed on the system, MINIMUM RUN REQUIRE-
MENTS provides the option to use the ELSD or disable it. Typi-
cally, ELSD method parameters are determined by the solvents 
used and are therefore somewhat universal when doing prepar-
ative separations of nonvolatile samples. Semi-volatile com-
pounds may require optimization of the ELSD parameters.

Note
The METHOD EDITOR should be used to change the ELSD 
parameters. 

For a PurIon If a PurIon mass spectrometer is connected, the MINIMUM RUN 
REQUIREMENTS window allows some customization of the PurIon 
operating conditions. This allows the use of default or commonly 
used methods while allowing customization of the separation for 
both masses used for fractionation or mass loading of sample 
sent to the PurIon for detection. (Low mass load is the default 
and sends the minimum amount of sample to the PurIon for 
detection. Due to the high concentrations of sample in a prepar-
ative separation, this is adequate for most samples with good 
ionization.)
PurIon detection options can also be accessed from the METHOD 
EDITOR. Further information about these options can be found in 
4.3.2  Method Editor (under Peak Detection).

3.3.1 Separation with an 
AutoInjector

1. Select START to start a separation. The MINIMUM RUN 
REQUIREMENTS window opens and, in front of it, the SAM-
PLE OPTIONS window.
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Figure 3-1 Selecting the sample, injection volume, and 
parameters

2. On the SAMPLE OPTIONS window, enter the TOTAL SAMPLE 
volume and the INJECTION VOLUME for each. Be aware that 
PeakTrak divides the total volume by the injection volume 
to determine the number of injections for each separation. 
The number of injections that these two volumes will yield 
is listed on the window.

Note
If you change loops on the system, it is important to enter the 
correct LOOP VOLUME (TOOLS > CONFIGURATION > the PREP 
SFC tab; see Section 2.6). This ensures that the samples 
entered do not greatly exceed the loop volume amount per 
injection.

During the programmed separation sequence, any changes 
made to the method are included on any of the remaining 
injections.

3. When no AutoSampler is installed or the FRACTIONATION 
VALVE is chosen for collection (Section 3.4), the COLLEC-
TION DEFINITION window opens as well.
a. Select a START and an END POSITION.
b. Select a CONTAINER CAPACITY.
c. When using a fractionation valve, FLUSH FRACTION-

ATION VALVE TUBING AFTER SEPARATION flushes the 
lines used during the run. The wash removes any sam-
ple that might be left inside the lines to improve sam-
ple recovery and to prepare the system for the next 
purification. See 3.4.1  SFC Fractionation Valve Line 
Wash for details.
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Note
If Wash Fractionation Valve Tubing by default is checked in the 
Tools > Configuration window, Flush Fractionation Valve will be 
checked on the Collection Definition window by default.

d. Dismiss the COLLECTION DEFINITION window.

Figure 3-2 The Collection Definition window

4. Otherwise, if collecting fractions on the AutoSampler, 
choose the rack and starting tube position on the MINU-
MUM RUN REQUIREMENTS window as needed.

Figure 3-3 Starting the equilibration from the Minimum 
Run Requirements window

5. After you START EQUILIBRATION, the system prompts you 
to place the sample probe into your sample container (or 
wash solvent container to prime the probe). Then, the sys-
tem prompts you to either load the sample or prime the 
probe.
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Figure 3-4 Sample probe prompt

Figure 3-5 Sample probe prime prompt

a. In most instances, you should prime the probe.
b. After the priming sequence is complete, the system 

presents the same two options and instructs you to lift 
the sample probe to insert a small air gap between the 
sample and priming solvent. Doing so prevents mixing 
during loading and ensures higher injection accuracy 
for the first few injections.

Figure 3-6 The probe air pull prompt

c. After the air gap is inserted, place the probe in the 
sample container and select LOAD SAMPLE.

Note
Ensure the sample container is secured and the sample probe 
is secured ensuring it is at the bottom of the sample container 
to ensure as much sample as possible is loaded.

Note
Note: The system begins any equilibration in the background 
but the run won't begin (and the equilibration will continue with 
the pumps running) until you acknowledge that the sample 
probe is in the sample container.

• If the sample probe is ever lost or damaged, it should be 
replaced with the AutoInjector Needle Assembly. (Visit 
https://store.teledyneisco.com for parts for your 
ACCQPrep SFC system, or contact your local Teledyne 
LABS representative.) 
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6. After the last injection is performed, a sample probe wash 
dialog is shown, prompting you to wash the probe with a 
strong solvent. Perform these duties as requested.

7. If FLUSH FRACTIONATION VALVE TUBING AFTER SEPARATION 
was configured (step 3c), an SFC fractionation valve line 
wash takes place. Messages are displayed during and after 
the fractionation line wash:

Figure 3-7 Messages during and after line washing

8. At the completion of the sequence, the final separation 
results are displayed.

Viewing previous 
separations

To view previous separations, select RESET to return to the HOME
screen:

• Select FILE > OPEN to view previous separations. 
If a sample had multiple injections, the run sequence will be dis-
played under a single name preceded by a “+” symbol. This 
symbol indicates there are multiple injections with the same 
base file name. Names are appended with “-I(#)” to signify the 
numerical order of the separation. For example:

• If you have a single injection run, it can be named A01.
• For multiple injections, the first injection is named 

A01-I1, the second is A01-I2, and the third is named 
A01-I3, etc.

9. Select the file you want to display. The RUN FILE window 
opens.

10. The remaining injections can be immediately viewed by 
selecting the left (<) or right (>) arrows at the lower left 
and right of the file viewer window This function can also 
be used to immediately view files before or after the cur-
rently viewed file even if they are not part of the same 
injection sequence.
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Figure 3-8 Viewing injections

3.3.2 AutoInjection 
Operating Steps

This section outlines the steps performed by the AutoInjector 
during sample injection.

1. A prompt appears, allowing you to either prime the sample 
probe with solvent or to place the sample probe into the 
sample container before the separation begins. Select 
PRIME PROBE and go to step 2; otherwise, proceed to step 3.

2. You are prompted to place the sample probe into the sam-
ple container before the separation begins. 

3. During column equilibrium, the sample loop is first placed 
into the run position. This position passes the cosolvent 
through the loop to wash out any leftover fluid from a pre-
vious separation and fills the loop with the cosolvent from 
the current separation. This prevents any strong solvent 
remaining in the loop from affecting the current separa-
tion.

4. Near the end of the equilibration, the injection valve moves 
to the sample load position.

5. The AutoInjector Module aspirates enough sample to fill 
the loop with the programmed amount and to compensate 
for the volume of the sample probe. 

6. After the equilibration has completed, the injection valve 
moves to the separation position and the separation pro-
cess continues.
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7. After the first separation has completed, the next separa-
tion begins with the equilibration as described in steps 3–
6. During this process, the AutoInjector Module continues 
to aspirate the programmed injection volume.

8. When the sample is aspirated for the final injection of the 
sequence, the total volume of all the sample injections 
matches the programmed amount. 

• If the sample container held less sample than 
programmed, the final injection aspirates a small 
amount of air. Small amounts of air will not damage the 
column. 

• If the sample container held more sample than 
programmed, there may be some sample remaining in 
the probe after the final injection. For this reason, 
programming the injection sequence with about 0.5 mL 
more sample volume than the actual sample amount 
provided in the sample container is recommended. This 
ensures all of your sample is processed. 

• If some sample remains in the sample probe (probe 
volume is approximately 43 mL), you can recover it by 
loosening the sample probe fitting at the injection valve 
to allow the sample to drain back into the sample 
container.

After completion of the final injection, the system washes the 
sample probe to prevent sample carryover during the next sepa-
ration. To perform the wash, the system prompts you to place the 
probe in a strong wash solvent. This solvent should be capable of 
completely washing the sample from the probe. Then, 10 mL of 
strong solvent is aspirated through the probe to wash away any 
remaining sample from the probe.

3.3.3 Separation using an 
AutoSampler Module

Verify that the wash station contains fluid. If it does not, go to 
TOOLS > AUTOMATION MANUAL CONTROL and select START WASH. 
After the wash station is primed, select STOP WASH. Ensure that 
the wash fluid supply container has sufficient clean wash fluid 
for the planned separations.
To begin a separation sequence with the AutoSampler Module, 
do any of the following:

• Create a sample queue entry.
• Select START to start with a single sample. 

Selecting START displays the MINIMUM RUN REQUIRE-
MENTS window, from which you can perform multiple 
injections on a single sample from the AutoSampler 
Module. A queue is created automatically.

• Access the RUN tab. This results in a screen and 
operation much like the standard ACCQPrep SFC 
system without an installed AutoSampler Module.

• Select the QUEUE button. This allows you to set up a 
separation sequence for multiple samples.



ACCQPrep® SFC 
Section 3   Operation

3-9EAR99 Technology Subject to Restrictions Contained on the Cover Page

3.3.4 Creating AutoSampler 
Queues

A queue can be created for use with the AutoSampler Module:
1. Install a sample vial rack before opening the QUEUE 

screen. This allows the software to limit sample program-
ming to the positions available for sample vials. 

2. Select the EDIT QUEUE button below Gradient Plot Area. 
The QUEUE screen opens (3.3.5  The Queue Screen). Select 
a row to edit its column entries. (You can also populate the 
screen with entries that you have saved to a file earlier 
using IMPORT SAMPLE LIST INTO QUEUE.) See Section 3.3.5 
for a discussion of the QUEUE screen’s column options.

Figure 3-9 The Edit Queue button

3. After the queue is complete, either select the RUN window 
and select the START or select the menu (≡) on the first 
unfinished run and select START RUN. In either case, the 
RUN REQUIREMENTS window appears. Accept or modify the 
starting rack or tube for fraction collection.

4. While a separation is in process, you can access the QUEUE 
screen to add samples to the queue. Samples that have 
been completed cannot be edited. They can be viewed, 
however, by touching the sample name corresponding to 
that run. 

5. During the separation, completed fraction racks can be 
removed when full and replaced with empty racks to allow 
continuous separations. If a single rack containing frac-
tions is removed and then replaced into the rack position, 
PeakTrak displays a prompt to determine if the rack con-
tains empty tubes. If you respond that the tubes are empty, 
PeakTrak considers this rack available for future separa-
tions. Otherwise, PeakTrak continues to mark this rack as 
full of samples and not available for fraction use. This fea-
ture allows you to remove a rack to obtain a sample for ver-
ification while leaving the rack in the instrument for 
convenience and later removal.

6. After the entire queue has completed, the RESULT window 
is displayed with the last separation. To easily view previ-
ous separations, select the separation on the QUEUE win-
dow or select FILE > OPEN to view previous separations.
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If a sample had multiple injections, the run sequence is displayed 
within the FILE > OPEN dialog under a single name preceded by a 
“+” symbol. This symbol indicates there are multiple injections 
with the same base file name. Names are appended with “-I(#)” 
to signify the numerical order of the separation. 
For example:

• If you have a single injection run, it can be named A01.
• For multiple injections, the first injection is named 

A01-I1, the second is A01-I2, and the third is named 
A01-I3, etc. 

Steps 1-6 show you how to create a queue from scratch. However, 
you can also export such a list to a plain text file (.txt) for future 
use by selecting EXPORT COLUMN/METHOD LIST. Later, you can 
import that list to populate the QUEUE screen by selecting 
IMPORT SAMPLE LIST INTO QUEUE.

3.3.5 The Queue Screen

Figure 3-10Automation Queue screen

Create new entries on the QUEUE screen by touching to add a 
row, then by editing the fields under each column.

Note
The number of rows in the queue is limited to 28. Additional 
samples can be added by deleting completed rows from the 
queue. If there are more rows than can be displayed on 
screen, up and down arrows that access hidden rows are dis-
played at the top and bottom of the screen.

≡ (menu icon) – Provides commands to start the separation 
(START RUN) from the QUEUE window, to remove a single row of 
an existing queue (REMOVE ROW), to ENABLE... or DISABLE 
POST-SEPARATION PAUSE, or to MOVE it to the QUEUE FOR LATER 
(Section 3.3.6).
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• ENABLE POST-SEPARATION PAUSE — Halts the system 
after the first separation is completed for the sample. 
This allows you to adjust the separation parameters on 
the basis of the results of the initial separation. This is 
especially useful to allow adjustment of the quantity of 
sample injected for each separation to optimize the 
loading on the column. After the initial pause, you can
· change the injection volume or otherwise modify the 

method as needed and disable the pause for the 
remaining injections, or

· leave it enabled to allow a second condition scouting 
separation.

Samples with pauses are easily found on the QUEUE win-
dow: their rows are highlighted.

Sample Name – Names each sample. Naming is optional. If left 
blank, the sample is named after the date and time the sepa-
ration was started.
Column  – Lists a separation column and an associated method 
for use. 
Method – After a column has been selected, the default method 
created for that column is automatically loaded. To change this 
method, touch the method name. A list of methods associated 
with the column appears. These methods are listed in the order 
they were created. Alternatively, select CUSTOMIZE CURRENT or 
BROWSE to populate this field. 
Select CUSTOMIZE CURRENT from the list of methods to create a 
modified version of the method for use in the current queue. To 
use this modified method, exit the method editor and select SAVE
when prompted. A new method named “Temporary 1” is created. 
This method will be used for all injections of the current sample 
and will be discarded after the sample is complete. All method 
parameters are saved with each separation. If you would like to 
save the modified method for later use, select SAVE AS before you 
exit the METHOD EDITOR and create a unique name for the new 
method.
Sample Position – The location of the sample for this sepa-
ration. If the sample size is too large for a single vial, create a 
second line in the queue and access the second vial.
Sample Volume – The amount of sample to be separated. Typi-
cally, the amount you enter is slightly greater than the amount 
of sample to ensure that all of the sample gets purified. This 
information is used in conjunction with the NUMBER OF INJEC-
TIONS column to calculate the volume of each injection. 
Injection Volume – Determines the number of injections in 
conjunction with the SAMPLE VOLUME column. 

The Sample Options 
Window

Selecting a row under the sample or injection columns opens the 
SAMPLE OPTIONS window that configures them. (Also, a version 
of this window may open when you start a separation.)
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Figure 3-11The Sample Options window

• TOTAL SAMPLE — The volume of the sample, in milli-
liters, selected from a list.

• INJECTION VOLUME — The volume of each injection, 
selected from a list. The number of injections (i.e., TOTAL 
SAMPLE ÷ INJECTION VOLUME) are listed below these 
settings.

• POST-SEPARATION PAUSE — Pauses the system between 
each injection. This allows fine-tuning of the gradient 
method, including INJECTION VOLUME, if desired. (An 
example of this is described in Section 3.3.9.)

• FRACTION POOLING — Collects peaks (compounds) in the 
same container. This reduces the number of containers 
used and combines the fractions containing the same 
compound from multiple injections. Works with both 
stacked and multiple injections. The TUBE ADVANCE 
button is available when this is selected.

Start Tube – Optimizes rack usage by sharing racks for mul-
tiple samples or optimizes work flow by placing each sample’s 
fraction into individual racks to support multiple users.
Export Column / Method List – Save the column / method list 
on the QUEUE screen to a text file for later use.
Import Sample List Into Queue – Populates the QUEUE tab 
with  a  method l is t  prev iousl y saved usi ng  E X P O R T 
COLUMN/METHOD LIST.

3.3.6 Queue for Later

Figure 3-12Edit Queue for Later
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This is similar to the QUEUE tab (Section 3.3.6). This allows you 
to add samples to the system without running. You can then get 
methods ready and run them when the sample is ready. As on 
the QUEUE tab, these queues can be saved (FILE > SAVE QUEUE 
AS). 

3.3.7 AutoSampler Injection 
Techniques

This  sec t i on descr ibes  operat ing protoco l s  for  the 
AutoSampler Module.

Note
The sequence of operations below is valid for software ver-
sions starting with 4.1.13. 

Injection Sequence The AutoSampler default technique injects samples and washes 
the sample probe using the wash station solvent.
For reference, the sample injection steps are listed below:

1. During column equilibrium, the sample loop is first placed 
into the run position. This position passes the cosolvent 
through the loop to clear out any air or CO2 that may have 
entered the loop. It also allows the wash solvent that is 
drawn up from the AutoSampler to be sent to waste 
instead of going into the loop.

Note
If the wash station solvent doesn’t match the cosolvent, reten-
tion time could be affected.

2. The sample probe is placed in the wash station.
3. About 1.5 mL of the solvent is pulled from the wash station 

through the probe to remove air from the probe line. 
4. The sample probe is lifted from the wash station and is 

moved up and down slightly. When the sample probe is 
dipped in the sample or solvent, some liquid sticks to the 
outside of the probe when it is raised. Therefore, the probe 
is moved up and down over the fluid source to shake off 
any excess liquid and to prevent the contamination of other 
samples or collection tubes. 

5. A small amount of air (0.05 mL) is drawn into the sample 
probe to minimize the mixing of the wash solvent and the 
soon to be loaded sample. This also minimizes the potential 
for the sample coming out of solution. 

6. The sample probe is moved to the sample container.
7. A portion of the programmed injection amount is aspirated 

into the sample probe displacing most of the wash solvent 
in the sample probe. This brings sample up to the injection 
valve, compensating for the volume of the sample probe. 
Since the loop is still in the separation position, the wash 
solvent is sent to waste.

8. The loop is switched to the load position.
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9. The remaining portion of the programmed injection volume 
is aspirated into the sample probe and loop. After the pro-
grammed amount of sample is aspirated into the probe, the 
probe is lifted out of the sample vial. 

10. The probe is moved up and down over the sample tube to 
shake off any excess liquid to prevent the contamination of 
other samples or collection tubes.

11. The probe is dipped into the wash station to pull in a little 
solvent.

12. The probe is lifted, then it pulls in 50 µL air before being 
dipped into the wash station to pull in a small amount of 
solvent. This solvent chases the sample through the probe, 
ensuring that all of the sample reaches the sample loop for 
injection.

13. Air is drawn into the sample probe to draw the remaining 
sample into the loop without leaving any sample in the 
probe. 

14. The sample is now loaded and the separation begins.
15. The next injection of the sample is accomplished by repeat-

ing the process described above. 
Probe washing sequence After the completion of the final injection of a sample, the system 

washes the probe:
1. The inject valve is moved to bypass to prevent contamina-

tion of the loop during the cleaning process. 
2. Air is drawn into the probe to eliminate any remaining sol-

vent in the probe.
3. The probe is placed into the wash station. The wash sta-

tion pump flushes wash fluid over the exterior of the probe 
while 10 mL of wash fluid is drawn into the probe to wash 
the interior flow path. The probe syringe pump uses half 
strokes to improve the rinsing of any tiny amounts of com-
pound that may be present due to the wash process. Once 
again, the probe is moved up and down over the wash sta-
tion to shake off any excess liquid and to prevent the con-
tamination of other samples or collection tubes. 

4. Air is drawn into the probe to eliminate the strong wash 
solvent from the sample flow path. 

3.3.8 Fraction Collection 
with the AutoSampler

If any racks are missing or identified as containing fractions 
from a previous separation, the system moves to the next 
available rack.

3.3.9 Stacked Injections Injections can be “stacked;” that is, multiple injections can be 
injected after each other during the same isocratic run. Stacked 
injections save time and solvent by eliminating the equilibration 
and dead time for each injection when running multiple injec-
tions. Therefore, they are useful for rapidly purifying a large 



ACCQPrep® SFC 
Section 3   Operation

3-15EAR99 Technology Subject to Restrictions Contained on the Cover Page

quantity of compound. PeakTrak provides both a means to set up 
multiple runs and a Stacked Injections Wizard from which you 
can fine-tune time windows.

Method Development The Focus Gradient Generator can be used to calculate an isoc-
ratic method. The Stacked Injections Wizard can then be used to 
determine the cycle time and the time windows for peak col-
lection. These are used to run stacked injections.

Setup for Multiple Runs Follow the steps below to set up the system for multiple runs.
1. Develop a method for an isocratic run, or use the Focus 

Gradient Generator to calculate an isocratic method from 
it. (See 2.6.9  Creating Scouting and Focused Gradients.)

Note
A previous run could be loaded and used as the basis for a new 
run method by making edits to parameters such as INJECTION 
VOLUME, FLOW RATE, % COSOLVENT, and WAVELENGTH. How-
ever, it is best to confirm that the changes give suitable separa-
tion before using the new method for a stacked injection run.

Note
Verify that there are no impurities eluting after the desired com-
pound(s).

a. Start with a scouting gradient run either from analyti-
cal SFC data or from scouting data from an 
ACCQPrep SFC system.

b. Select the FOCUS GRADIENT button on a RUN VIEWER 
window to open the Focus Gradient Generator window.

c. Calculate the purification method:
· Select a column.
· Select the peak of interest.
· Set the FOCUS RANGE to +/- 0% Isocratic.
d. Select FOCUS to close the window. A method is gener-

ated and displayed on the MAIN screen. 
e. Delete the two step gradient points at the end of the 

run to create an isocratic method. (The software is not 
be able to create a stacked injection unless the gradient 
run is completely isocratic.)

f. Select START to start the run. THE MINIMUM RUN 
REQUIREMENTS and SAMPLE OPTION windows open.

2. Create the collection time windows 
a. Select EXTERNAL SAMPLE on the SAMPLE OPTIONS win-

dow.
· For systems equipped with an AutoSampler, 

disconnect the sample probe at the injection port and 
replace it with the AutoInjector probe 
(PN 60-5234-657).
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· No probe change is needed for units with only an 
AutoInjector.

b. Select POST-SEPARATION PAUSE between injections so 
that the system is paused between each injection to 
allow the gradient method—including injection vol-
umn—can be fine-tuned without configuring the sys-
tem for an entirely new run.

Note
The POST-SEPARATION PAUSE is the only time at which run 
parameters can be modified during a run.

c. Enter the TOTAL SAMPLE volume and INJECTION VOL-
UME for each run. To initially fine-tune the method, 
enter a small injection volume such as 0.2 mL (see Fig-
ure 3-11), as you will be able to change it later.

d. Select OK to close the SAMPLE OPTIONS window and 
reveal the MINIMUM RUN REQUIREMENTS window.

e. Check solvent amounts; if these are acceptable, select 
START EQUILIBRATION. A RUN window opens after the 
run is finished.

f. Select PEAKS on the RUN VIEWER window. Detected 
peaks are be used to determine the initial time win-
dows to use for the stacked injections. (Do not worry 
that there are so many injections, as this number will 
decrease when the sample volume is increased.) Peak 
collection is discussed in Sections 4.3 and 4.3.2.

g. If needed, select EDIT INJECTION or EDIT METHOD to 
adjust either the injection volume and/or the solvent 
composition.

h. Select CONTINUE to run the method with the same or 
with changed parameters. 

i. Once you are satisfied with the results of the single 
injection, select STACK INJECTIONS on the RUN VIEWER 
window. The STACKED INJECTION window opens. The 
system cdisplays a simulated stacked injection based 
on the isocratic run. The time windows displayed are 
based on the isocratic peak collection. 

j. Adjust STACKED INJECTION settings as required. If no 
peaks were collected during the isocratic run, time win-
dows are not displayed, but you can add them there 
manually. See The Stacked Injection window below for 
more information.

3. Prepare to run the stacked injections.
a. Verify that there is enough solvent (as listed on the 

MINIMUM RUN REQUIREMENTS window).
b. Verify that the waste container is empty.
c. Confirm that the sample is in place.
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d. Run the stacked injections by selecting OK on the 
STACKED INJECTIONS window.

Exiting the STACKED INJECTIONS window brings you back to the 
MAIN screen. If you select TERMINATE button at MAIN, PeakTrak 
offers you the option to continue, to terminate the run, or to 
cancel:

• STOP INJECTING AND CONTINUE RUN stops any further 
injections from occurring but allows any injections that 
are still in the column to finish. The probe wash 
procedure is then implemented to clean sample from the 
probe.

• TERMINATE RUN NOW immediately ends the run. Sample 
may be left in the injection loop and on the column; this 
eventually needs to be washed out of the column. As 
with STOP INJECTING, the probe wash procedure is run.

• CANCEL continues the current purification.

Figure 3-13Stopping stacked injections

Example Run An example run is shown in Figure 3-14, where there was a lot of 
resolution between the peaks. The high resolution allowed more 
sample to be loaded.

Figure 3-14Chromatogram showing High Resolution at 
the end of a run

Features are provided to make further adjustments as necessary:
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EDIT INJECTION - Allows the injection volume to be changed. In 
our example, the injection volume was changed to 2.0 mL for the 
next injection because the run suggested that there was suffi-
cient resolution for a larger injection.
CONTINUE WITH PAUSE is found on a PEAKTRAK window (Figure 
3-15); selecting it pauses the run after the next injection for 
further adjustments and also allows a stacked injection to be per-
formed if that injection is suitable to be stacked.

Figure 3-15The PeakTrak window.

Setting up the stacked 
injection

Once the run looks good, stacked injections can be run 
(Figure 3-16).

Figure 3-16Higher sample loading, ready for stacked 
injections

Selecting the STACK INJECTIONS button just below the chro-
matogram (shown circled in Figure 3-16) starts the Stacked 
Injections Wizard and opens the STACKED INJECTIONS window 
(Figures 3-17, 3-18, 3-19, and 3-20).

The Stacked Injection 
window

Figure 3-17 shows a simulation of three stacked injections. The 
various time windows were determined from the fraction col-
lection and were used to determine the cycle time. The up and 
down arrows near the START and END settings allow fine tuning 
of the time window without entering values. The different colors 
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(green and brown) represent a different stacked injection. The 
crosshatch patterns represent different time windows within an 
injection.

Figure 3-17Simulated stacked injections for the run in 
Figure 3-16

Depending on the complexity of the chromatogram, it may be 
easier to adjust the time windows within the context of a single 
injection. Checking SHOW SINGLE INJECTION limits the view to 
one injection (Figure 3-18).

Figure 3-18Stacked Injections window in a 
Single Injection view

Using the single injection view, it is easy to add a third time 
window if there is concern about mixing the two compounds 
(Figure 3-19). This time window can be added at the end of the 
list, and the time windows can be adjusted to accommodate the 
new one.
If no fractions were collected during the previous steps, SHOW 
SINGLE INJECTION also permits easier manual time window set-
tings.
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Figure 3-19Adding a Third Time Window

Deselecting SHOW SINGLE INJECTION shows a simulation of three 
injections with the third collection window. The effects of 
changing the CYCLE TIME can be most easily viewed in this 
mode. Although the system remembers the injection volume, 
enter the total volume of sample before selecting OK.
After OK is selected, the system starts to run stacked injections.

Figure 3-20Three Injections with a Third Time Window

Monitoring the injections During the run, selecting STACK INJECTIONS allows all the 
parameters for stacked injections to be adjusted during the run 
as needed.
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Figure 3-21Four Stacked Injections with Time Windows 
Adjusted

Stacked Injections window 
options

As on the MAIN screen, you can ZOOM IN and MODIFY VIEW.
Show Single Injection – Shows a single injection on the chro-
matogram. This view is useful for adjusting the time windows. 
For example, adjusting the time window to appear a bit larger 
than the collected peak can maximize sample recovery by col-
lecting the peak's tail.

Cycle Time – A time in minutes. Displaying the set of three sim-
ulated injections allows a visual determination of the proper 
cycle time. When peak widths are adjusted, the CYCLE TIME will 
likely need to be changed also so that there is a small gap 
between the collection windows.

Total Sample – A sample volume in mL.

Injection Volume – By default, the value used from the last iso-
cratic injection prior to entering the STACKED INJECTION window. 
Verify that this is the total volume of the sample before selecting 
OK.

Fraction Pooling – Collects corresponding peaks in the same 
container. This is the default. The largest possible containers 
should be used to minimize the number of fractions. FRACTION 
POOLING interacts with COLLECTION to determine peak collection 
behavior, as summarized in Table 3-1. The TUBE ADVANCE button 
is available when this is selected.

Time Window entry – Select ing a row enables  that time 
window. Disabling a time window turns off peak collection—
whether a peak is present or not—during that time. This allows 
impurities to be ignored.

Start  – The start of the time window in minutes.

End – The start of the time window in minutes. 

Collection – Determines which peaks are collected, if any. COL-
LECTION interacts with FRACTION POOLING to determine peak 
collection behavior, as summarized in Table 3-1.
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3.4 Fraction Collection 
with Fractionation 
Valve

The fractionation valve is  an alternate method to the 
AutoSampler fraction collector to collect peaks. A larger volume 
can be collected into individual fractions compared to the con-
tainers on the AutoSampler. However, the fractionation valve is 
limited to eight fractions.
To use the fractionation valve, select START, then follow the pro-
cedure described in Section 3.3, but choose these settings:

1. On the MINIMUM RUN REQUIREMENTS window, choose the 
fractionation valve instead of one of the racks 
(Figure 3-22).

Figure 3-22The Minimum Run Requirements window

2. On the COLLECTION DEFINITION window
a. Enter the maximum fill volume for the containers used 

with the fractionation valve. “Max” is the value stored 
in the system configuration, but other values up to 
5000 mL may be entered.

b. Optionally, check FLUSH FRACTIONATION VALVE TUB-
ING.

Table 3-1  Time window collection

Fraction Pooling on Fraction Pooling off

Peaks Only the first detected peak is 
collected. Everything else 
diverted to waste.

Detected peaks collected in dif-
ferent containers. Non-peak 
eluant diverted to waste. 

All No peak detection. Everything 
within the time window col-
lected into the same container.

Peak detection is enabled. 
Peaks in different containers. 
Non-peak eluant collected as 
fractions.
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c. Dismiss the window.

Figure 3-23Collection options

Note
If Wash Fractionation Valve Tubing by default is checked in the 
Tools > Configuration window, Flush Fractionation Valve will be 
checked on the Collection Definition window by default.

Fractionation bottle status 
area

Selecting START EQUILIBRATION from the MINIMUM RUN 
REQUIREMENTS window adds bottle icons below the COLUMN, 
FLOW RATE, and COSOLVENT options on the MAIN screen. These 
icons show the fill status of fractionation valve containers.

Figure 3-24Fraction bottle status area

Figure 3-25Fraction bottle status icons

You can reuse a fractionation valve container by selecting a full 
bottle icon after filling has stopped and the valve has advanced to 
the next empty container. PeakTrak will pause filling and 
prompt you to empty the container before continuing.

bottle is 
filling

bottle is 
full

bottle will 
be filled 
next

bottle is 
empty
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3.4.1 SFC Fractionation 
Valve Line Wash

The SFC fractionation valve line wash flushes the lines used 
during the run. It removes any sample that might be left inside 
the lines to improve sample recovery and to prepare the system 
for the next purification. A line wash can be requested for some 
or all separations:

• The procedure can be enabled or disabled for each 
individual run by checking FLUSH FRACTIONATION 
VALVE TUBING AFTER SEPARATION on the COLLECTION 
DEFINITION window.

• The procedure can be enabled by default for all purifica-
tions using the fractionation valve by checking TOOLS > 
CONFIGURATION > the USER PREFERENCES tab > WASH 
FRACTIONATION VALVE TUBING BY DEFAULT.

How does it work? At the end of a run, the eluate composition at the end of the run 
is used to flush any lines used during the purification. Because 
approximately 5 mL of co-solvent is used for each line, the time 
required for the flush depends on the flow rate, % composition, 
and number of bottles used.
If the run is RESET, their will be no line wash. Use TERMINATE 
(the “fast-forward” button) to end the run early, which allows all 
the instrument cleaning procedures to be run.

3.5 Operation 
Troubleshooting

Injection Valve Leak  – Refer to Section 5.5.2  Injection Valve 
Rotor. Recommendations:

• Failure to filter the sample can allow particles to scratch 
the valve sealing surface. Filter the sample with a 
20 µm or finer filter.

• Dissolve sample in sufficient solvent so that evaporation 
of solvent doesn’t cause formation of crystals

• Formic acid modifiers can result in reduced injection 
valve seal lifetime. If possible, consider other modifiers 
such as TFA.

Unexpected retention time or variable retention times for 
repeated injections – 

• Temperature or back pressure variation. Variations of 
only a few degrees can cause a visible retention time 
shift.

• Variable flow rates of CO2 or the co-solvent:
· Check valves may require cleaning or replacement 

due to contamination from solvents or pump seal 
wear particles.

· Inadequate priming of the pump may cause the 
cosolvent to flow at lower rates. This may be due to 
sticking check valves. Open the front panel and tap 
the check valves with a wrench while priming to 
assist in bubble passage through the pump.
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· Solvent supply fitting may be loose allowing small 
amounts of air into system, causing minor flow rate 
errors of CO2 or the co-solvent.

· Strong solvent used for injection (if the repeated 
injection is a larger volume).

• Solvent bottle refilled with incorrect solvent.

No peaks on chromatogram – 
• No sample injected:

· Sample vial empty.
· Sample probe plugged, injection loop plugged, or 

probe or injection pump fitting loose.
· Perform a dummy injection and watch injector 

pump to determine if fluid is being aspirated. 
Disconnect tubing at different points and place 
into fluid to determine location of problem.

· If loose fitting, tighten or replace if needed.
· If plugged, replace part or connect to a high 

pressure pump to dislodge plug.
• Incorrect wavelength used (assuming no other detectors 

than UV/UV-vis).
• Compound doesn’t absorb light.
• Co-solvent not being delivered. Check solvent level, 

connections, check valves, confirm solvent lines in 
correct bottles, and look for leaks.

• Solvent gradient method too weak to elute sample
• Leak in system is preventing fluid from reaching the 

detector.
• UV or UV-Vis detector not functioning (the baseline is 

completely flat with no visible noise.
· Liquid could be trapped in the detection gap 

due to immiscible solvents. When changing 
from normal to reverse phase, flush system 
with an intermediate solvent miscible with 
both phases such as isopropanol, or flush 
system when changing phases in order of 
polarity. 

· Flow cell detection gap obstructed. Remove 
the flow cell from the system and view 
through the liquid path. The detection rods 
should be visible with a small gap between 
the rods.

· This is not a lamp or detector hardware 
problem. Those failures have corresponding 
error messages.

Peaks elute too early – 
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• Carbon dioxide not being delivered properly. Check 
solvent level, inspect or clean pump A check valves, 
confirm solvent lines in correct solvents, and look for 
leaks of air into the lines.

• Sample injected in a strong solvent that carries the 
sample down the column.

• Column not suitable for the compounds separated.
• Incorrect method.

Peaks elute too late – 
• Co-solvent not being delivered properly. Check solvent 

level, inspect or clean co-solvent pump check valves, 
confirm solvent lines in correct solvents, and look for 
leaks of air into the lines.

• Improper flow rate for one or more solvents. Check the 
flow rates of both solvents. If flow of one of the solvents 
is only half of the expected flow, prime the system again 
since one of the pump heads isn’t primed. If still unsuc-
cessful, open the front cover and tap on the heads of the 
problem pump.

• Column not suitable for the compounds separated.
• Incorrect method. 

Poor peak shape – 
• Solvent modifier needed for sample.
• Sample injected in strong solvent.
• Column (or guard column) has voids (or other damage, 

such as loss of bonded phase). 

“Phantom” or “Ghost” peaks  – Sometimes peaks appear as a 
broad peak in an area of sharp peaks. Possible causes and their 
remedies:

• The column requires washing. Wash the column with 
strong solvent. 

• A compound is left from a prior injection. Make sure 
that the gradient goes to 70% co-solvent in each 
separation to ensure all compounds are washed from the 
column.

• Impurities in solvent. Evaluate with runs with no 
sample injection to determine if impurity is from the 
sample. Make a run with a standard injection volume, 
then double the equilibration time. If the peak in 
question become larger, it is solvent related. Check 
mobile phase quality, check for fungal/bacterial growth, 
or ignore the peak. 

Drifting baselines – 
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• Mobile phase absorbance, which may be due to an 
impurity in the solvent or a solvent modifier.

• Column not equilibrated. Increase the equilibration 
time to determine if this solves the problem.

• A compound from a previous run was not fully washed 
from the column and is slowly washing out of the 
column. Wash the column with strong solvent to 
eliminate compounds from prior separations. 

ELSD detection issues – 
• No peaks detected

· If the compounds are volatile, they may not be 
detected by ELSD or may need a lower drift tube 
temperature. Refer to the discussion on ELSD 
operation in Section 4.3.2 before adjusting the ELSD 
operating temperatures.

· If the system detects peak shortly after the first 
separation of the day and then fails to detect, the 
drift tube temperature may be too low to vaporize the 
solvent aerosol. Refer to the discussion on ELSD 
operation in Section 4.3.2 before adjusting the ELSD 
operating temperatures.

· Increase ELSD sensitivity and gain in the method 
editor to see if the peaks are simply too small to be 
easily seen.

· Internal tubing that splits flow from the system to 
the ELSD may be blocked. Remove the tubing from 
the nebulizer during operation to verify flow through 
the tubing. If plugged replace both segments of 
tubing.

• Weak UV or ELSD peaks
· Each detector has a different response to compounds 

and may be more or less sensitive to compounds than 
the other detector.

· Semivolatile compounds may be difficult to detect or 
may benefit from modification of the ELSD sensi-
tivity, gain or operating temperatures. Refer to the 
discussion on ELSD operation in Section 4.3.2 before 
adjusting the ELSD operating temperatures.

• UV and ELSD signals aren’t aligned in time
· The peak widths or shapes of the 2 signals may vary 

due to varying sensitivity of the 2 detectors causing 
the alignment to appear incorrect.

· If the signals sometimes appear a few seconds out of 
alignment it could be normal due to different peak 
shapes common with ELSD.

· Partial blockage of the ELSD tubing could reduce 
flow to the ELSD causing the ELSD signal to lag the 
UV signal.
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• UV or ELSD peaks are broader than the other detector.
· This is normal due the detector response and a small 

increase in dispersion in the alignment compensation 
tubing. 

PurIon detection problems – 
• Little or no mass spectrum detected on the method 

development window, but compound should be visible.
· Sample is dissolved in a solvent not suitable for MS 

injection such as DMSO or DMF. Dissolve in 
methanol or acetonitrile and try again.

· Try other ionization parameters, such as switching to 
“Robust”.

· Verify that the gas supply is functioning. Small 
peaks may be visible without the gas. Nitrogen is 
typically used.

· Make sure the proper gas is supplied. Argon will 
cause arcing resulting in noise.

· Fluid interface carrier solvent bottle empty. 
• MS peaks occur later than peaks from the other detector 

such as UV.
The MS carrier fluid flow rate is too low. Check that the fluid 
interface priming port is fully closed. Check the carrier pump 
seals for leakage. Clean or replace the carrier pump check valves. 

Excessive system pressure – 
• Improper connections:

· Verify that the column is connected properly to the 
Column Select Valve. (If the column output goes to 
the wrong port, it is dead-ended.)

• Column gets clogged:
d. Remove guard column (if installed) and check 

back pressure. If this corrects the problem, 
replace the guard column or follow the washing 
procedure below.

e. Remove preparative column and check back 
pressure.

f. If the column is clogged, use a non-SFC system 
to try flushing with stronger solvent than mobile 
phase. (This procedure may damage polymeric 
reverse phases.) A flush protocol could include: 
100% MeOH or ACN without buffers or modifiers 
followed by 100% DCM, followed by 100% hex-
anes. Reverse the order of solvents to get back to 
100% ACN or MeOH.

g. Reverse the column connections and flush.
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h. Place the column outlet (which was originally 
the column inlet) over a beaker so any particle 
that are flushed out don’t get into the system.

i. Filter samples in the future to prevent problems. 

Fractions not correct volume – 
• Air trapped in pump head:

· Reprime and test again.
· Some cosolvent may be lost to evaporation from the 

expansion of CO2 during fraction collection.
• Air leak in inlet lines:

· Remove front panel and examine inlet lines while 
operating. If small air bubbles exist, follow tubing 
back to source, examining for source of air bubbles. 

Injection valve dripping – 
• Valve rotor is damaged due to particulates in the flow 

stream or injected sample.
• Replace the rotor. The Accessory Kit (PN 60-5269-011) 

includes the rotor. See Section 5.5.2  Injection Valve 
Rotor for the replacement procedure.

Parts for ACCQPrep SFC systems are available online at 
https://store.teledyneisco.com. 
Or, contact your local Teledyne LABS representative.
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ACCQPrep® SFC

Section 4  PeakTrak

4.1 Overview PeakTrak is the software that controls the ACCQPrep SFC 
system. This section discusses the basic functionality of 
PeakTrak when operated via the touchscreen or a remote 
browser window.

4.1.1 PeakTrak Window 
Elements

The MAIN screen displays the current METHOD FILE. From MAIN,
you can access many of PeakTrak’s features, view the system 
status, and view or edit the method file settings. The MAIN
screen can be divided into the following regions:
Menu  – The topmost item in the window is the PEAKTRAK 
MENU from which you can access all of PeakTrak’s features.
System Status  – PeakTrak displays the system status just 
below the menu. Status messages may indicate

• the system mode,
• the current position in a run, expressed in time or 

column volumes,
• the current %co-solvent, and
• the flow rate.

Main Region – Here, you can view or modify method file set-
tings. Frequently used method settings are displayed on the 
MAIN screen, while advanced method settings are displayed on 
the METHOD EDITOR.
Many of the PEAKTRAK windows contain these main elements or 
a subset of them (Figure 4-1). 
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Figure 4-1 The Main screen

Note
The available commands and options will change according to 
the active window, the state of the system, and the current file.

4.1.2 Method File PeakTrak controls the separations performed by the system 
through a METHOD FILE. You do not have to create a complete 
method to perform a separation. When the system is turned on, it 
associates a default method in the system with the column 
selected as a default in the CONFIGURATION window. In a single 
column system, this reflects the column mounted on the system. 
This default method is stored on the system hard drive, and a 
copy of the method is automatically loaded into a temporary use 
area.
If the default method meets your needs, select START to start a 
separation. On the other hand, if you want to customize the 
method for use on this separation only, edit the method. (Editing 
the gradient by dragging a gradient point is a common modifi-
cation.) This modified gradient will be used for the separation. 
This method is not saved for later reuse unless you select FILE > 
SAVE METHOD and then name the method. If you didn’t save the 
method, but you later want to reuse it, open a data file that used 
the method and extract it for reuse. The system uses the method 
file in the temporary area to direct the system operation after 
you select START.



ACCQPrep® SFC 
Section 4   PeakTrak

4-3EAR99 Technology Subject to Restrictions Contained on the Cover Page

PeakTrak categorizes the method settings as Basic or Advanced. 
Basic settings are the frequently used controls accessed through 
the MAIN window. Use the METHOD EDITOR window to access the 
advanced settings.
Method files are stored by the system and can be opened for 
review, reuse, or modification. To open a method file, use the 
FILE > OPEN. Method files have a .pmtd file name extension.

Default Methods When PeakTrak is started, the system loads a Default Method. A 
Default Method contains Teledyne-recommended basic and 
advanced settings for the use of a default column (as selected on 
the CONFIGURATION window). There can be a Default Method for 
each size and type of column defined in the CONFIGURATION
window.
Default Methods provide a starting point for your separation or 
purification. From these initial settings, you can perform a puri-
fication run, or you can modify the settings for your next run. 
Subsequent runs will use the settings in the active (temporary) 
window. If you have modified the settings, you can save the 
Method file for future use.
If you find that the Default Methods are not a practical starting 
point for your applications, the Default Methods can be changed 
to meet your specific requirements.

4.1.3 Run File When the system has finished a run, it saves the run data in a 
Run file. This includes the method parameters used during the 
separation, rack and tube information, a pressure trace of system 
pressure, spectral data, a chromatogram containing information 
from each of the detectors, and (optionally) mass spectrometer 
spectral data (if one is installed). The saved method parameters 
do not include reference to the method name, as that method 
could have subsequently been edited to different parameters.
You can open and review the run files stored by the system. To 
open a Run File, use FILE > OPEN. Run files have the .run 
filename extension. For more information about viewing runs, 
see Section 4.4.7  Viewing Runs.

4.2 PeakTrak Menu 
Options

PeakTrak main menu options:
• FILE

• METHOD EDITOR

• MS
• TOOLS

• HELP

4.2.1 File The FILE menu provides commands to perform file operations, 
print, and log out of the system:
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Figure 4-2 The File menu

New – Opens a new method file. PeakTrak opens the MAIN 
window using the default program settings for the default 
configured column size.

Open – Opens a Method file (.pmtd) or a Run file (.run) 
stored on the system’s internal hard drive.

Manage Files – Opens a window from which you can archive 
or delete method and run files from the current directory. 
You can archive files by connecting a USB Flash drive and 
selecting the COPY FILES... or the MOVE FILES TO FLASH 
DRIVE option.

• To remove a file from the internal hard drive, highlight 
the file or enter the filename, then select DELETE.

• To remove multiple files, you can drag to highlight 
multiple files, or select DELETE BY AGE. Then specify the 
age limit in months and select OK.

Note
Use the MOVE and DELETE options with caution, as the files 
cannot be recovered from the internal hard drive once the 
action is complete.

Set Data Path – Opens the Set Data Path window to specify 
your default METHOD file and RUN FILE storage folder 
location. Different users can have their own data paths. 

Save Method – Saves the settings of the current method file 
to the system’s internal storage. If the method is not named, 
SAVE METHOD prompts you to name the file.
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Note
DEFAULT METHODS are an exception and cannot be overwritten 
by SAVE METHOD. If a DEFAULT METHOD is open and you 
attempt to save any modifications to that method, the FILES
window appears, so you can rename the method file. This pre-
serves the default method. The DEFAULT METHOD must be 
edited in the Prep SFC tab on the CONFIGURATION window. 

Save Method As – Renames the current method with a 
name that you choose and saves it on the system’s internal 
hard drive. 

Save Run As PDF – Saves the displayed run. The default 
file name for the run is the same as for the Run file, except 
it has a .pdf file name extension. (PDF files can be opened 
and printed on the external computer with Adobe Reader, 
for example.) If you select SAVE RUN AS PDF from the 
touchscreen, a file download window opens on which you 
can select a location and enter a file name. If you select 
SAVE RUN AS PDF from a remote computer, the file is saved 
to the remote computer’s hard drive.

Save Run As Text – Saves the displayed run. The default 
file name for the run is the same as for the Run file, except 
it has a .txt file name extension. “TXT” files are actually 
XML code. These files can be opened with text editing 
software. They can also be imported into a spreadsheet for 
data manipulation. If you select SAVE RUN AS TXT from the 
touchscreen, a file download window opens on which you 
can select a location and enter a file name. If you select 
SAVE RUN AS TXT from a remote computer, the file is saved 
to the remote computer’s hard drive.

Save Queue As – Saves the queue on the system’s internal 
hard drive for later use. The file name is given the .queue 
extension.

Print – Prints the completed run on the network printer if 
selected from the touchscreen. If selected from a remotely 
connected computer, PeakTrak displays the printer 
window. From this window, you can select and configure the 
printer of your choice. After configuring the settings, PRINT 
the completed run.

Logout – Logs you out of the system. After logging out, the 
system displays a login screen and waits for the next user to 
log in.

4.2.2 Method Editor (menu 
item)

Selecting the METHOD EDITOR menu command opens the 
METHOD EDITOR window. Use this window to view and modify 
basic and advanced METHOD FILE settings. (See Section 4.3.2 
Method Editor for detailed information about the Method Editor 
window.)
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4.2.3 MS The MS menu item is only available when a PurIon Mass 
Spectrometer is added to the ACCQPrep system. Furthermore, 
Method Development, Manual Control, and Ionization Settings 
are not available from a remotely connected computer via a web 
browser.

Figure 4-3 The MS menu

Method Development – Opens the MS METHOD 
DEVELOPMENT window to verify ionization conditions for 
the compounds to be purified and to provide access to the 
Ion Finder (see Section 4.3.7). METHOD DEVELOPMENT is not 
available from a remotely connected computer via a web 
browser. 

Manual Control – Opens the MS MANUAL CONTROL window 
to control the carrier solvent pump and switching valve on 
the mass spectrometer fluid interface. MANUAL CONTROL is 
not available from a remotely connected computer via a web 
browser.

Ionization Settings – Opens the IONIZATION SETTINGS 
window to allow creation of custom ionization parameters 
that can be saved for various compound classes and 
projects. This command is not available from a remotely 
connected computer via a web browser.

Operate – Sets the status of the PurIon mass spectrometer 
from standby to an operational mode by applying power to 
the heaters and dynode detector. The nitrogen gas is also 
supplied to the nebulizer. If the mass spectrometer is 
already in operate mode, the STANDBY button replaces 
OPERATE.

Standby – Available when the PurIon is in the operate 
mode. It turns off all high voltages within the PurIon 
including the dynode detector, which prolongs its life. 
Additionally, it sets the inlet capillary heater temperature 
to 50 °C, turns the remaining heaters off, and lowers the 
gas flow rate to about 0.2 liters/minute. When in standby 
mode, OPERATE is used to return the PurIon to the 
operational state (i.e., high voltages on, heaters on, and gas 
flow at the proper rate of about 4 liters/min). When the 
mass spectrometer is already in standby mode, STANDBY is 
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unavailable; the OPERATE button displays instead.
Shutdown – Removes power to the heaters, and removes 

power from the turbomolecular pump. A window appears 
confirming that you want to initiate the shutdown 
procedure. Use SHUTDOWN to shut down the PurIon mass 
spectrometer for maintenance or to move the system.

WARNING
When a PurIon is installed, do not shut down or disconnect 
the vacuum line to the roughing pump until the PurIon is 
fully vented as indicated by PeakTrak.

4.2.4 Tools The TOOLS menu provides options to configure and manually 
control your ACCQPrep SFC system:

Figure 4-4 The Tools menu

Manual Control – Opens the MANUAL CONTROL window. 
From this window, you can operate the system manually. 
Manual control can assist with priming or purging the 
internal plumbing, and aid system troubleshooting. Options 
on the MANUAL CONTROL window are covered in detail in 
Section 4.3.10  Manual Control.

Automation Manual Control – Provides tools to prime the 
wash station and to manually wash the probe or injection 
loop.

Auto Zero – Zeros the detector trace(s) during a run.
Configuration – Opens the CONFIGURATION window. From 

this window, you can specify the solvents used with the 
system, set default volumes for collection tubes, set the 
system date and time, configure network settings, etc. 
Options on the CONFIGURATION window are covered in 
detail in Section 2.1  Configuration of the ACCQPrep SFC.

Set Administrator Password – Opens the SET 
ADMINISTRATOR PASSWORD window. 

Passwords prevent unauthorized modifications to:
• User management
• System date and time
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• System password
If password protection is enabled, you must enter a password 
before any of these settings can be accessed.
The default password set on the system is “accqprep”. Refer to 
Section 4.3.12  Set Administrator Password to change it. 
Password protection can also be disabled so that all users can 
modify the entry.
User Management – Opens the USER MANAGEMENT 

window. You can use this window to add or remove users 
from the system. 

• To add a user, select ADD NEW and enter the user name 
in the window that appears. A PASSWORD window 
appears; enter a password for the new user, or leave the 
text empty if no password is wanted. When you add a 
user, a working folder for that user is automatically 
created. When the user logs in, the user’s data files will 
be automatically stored in their user folder. It will be 
reset when logging out.  Use FILE > SET DATA PATH to 
select your folder. To prevent unauthorized changes to 
user management, this function is password protected.

• To delete a user, select the DELETE button next to the 
user’s name and confirm the action. 

• To change a password, select the CHANGE PASSWORD 
button to change the password for a user. 

• To delete a password, leave the text box empty.
After users are created, they can be assigned access levels for the 
system (Figure 4-5; this table is available when you select Help 
on the USER MANAGEMENT window).

Figure 4-5 Table of user level access

Vent System Pressure – Opens a dialog from which you can 
confirm that you want to vent the system. 
Recovery Run – Continues a previous separation after an error 
to recover sample from the column

Function Administrator 
Standard 

User 
Limited 

User 
Restricted 

User 
Administrative Functions:  User Management,
Service Screens, etc. 

x

Configuration Screen  x x
File Management: Move, Copy, Rename, 
Delete, etc. Runs and Methods 

x x x

Edit every gradient point x x 
Modify run length x x 
Edit gradient points before wash stage x x x 
Select solvent for the run x x x x 
Modify detection parameters for the run x x x x 
Modify collection parameters for the run
Prime / Manual Control x x x x 

x x x x 
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4.2.5 Help The HELP menu provides options to service your ACCQPrep 
SFC system and to report information about it.

Figure 4-6 The Help menu

Service – Allows access to the system’s service functions by 
qualified service personnel. These service functions are 
password protected to restrict their use to only trained 
personnel. Access to these functions requires the 
administrator password.

Software Update – Opens a window to install patch files to 
update your ACCQPrep system software.

Export Log Files – Writes operating data to a log file during 
system operation. If you are accessing the system over a 
network, the files are saved to your PC; otherwise, they are 
saved to a connected USB drive. Teledyne LABS service 
personnel can interpret this data to optimize system 
performance or to troubleshoot difficulties. Teledyne LABS 
recommends that you use EXPORT LOG FILES only when 
advised by a qualified service technician.

Backup / Restore – Opens a window to backup a 
configuration, columns and methods, users, or user data to 
a ZIP file or restore it from the file. Access to these 
functions requires the administrator password.

About PeakTrak – Reports version information for 
PeakTrak and for firmware, and displays networking 
addresses.

About ISCO – Displays contact information for 
Teledyne ISCO, a unit of Teledyne. You may contact 
Teledyne LABS at www.teledynelabs.com.



ACCQPrep® SFC 
Section 4   PeakTrak

4-10 EAR99 Technology Subject to Restrictions Contained on the Cover Page

4.2.6 Backup / Restore 
Procedures

To back up instrument settings and data:
1. Plug in a USB drive.
2. Select HELP > BACKUP / RESTORE. The BACKUP / RESTORE 

window opens.
3. Select BACKUP. A backup file is saved to the USB drive.

To restore instrument settings and data from a backup:
1. Plug in a USB drive containing the backup file.
2. Select HELP > BACKUP / RESTORE. The BACKUP / RESTORE 

window opens.
3. On the window, select items from the backup file that you 

want restored.
4. Select RESTORE.

4.3 PeakTrak Windows This section contains descriptions of the windows used for most 
PeakTrak tasks:

• Main screen
• Method Editor
• Column Data
• Files
• Set Data Path
• MS Method Development
• MS Manual Control
• MS Ionization Settings
• Manual Control
• Set Administrator Password

4.3.1 Main screen The MAIN screen gives you control of frequently used functions 
before and during the run. After a run, or when viewing previous 
runs, MAIN displays peak collection data and the settings used 
for that run. MAIN dynamically changes to display the controls 
required for the current state of the system. The top region of 
MAIN always displays a GRADIENT PLOT area. The bottom region 
of the screen displays the RUN SETTINGS, RUN CONTROL buttons, 
and PEAK COLLECTION buttons. After a run, the left side of the 
window changes to show the collection rack map or the method 
parameters in a PEAK COLLECTION DATA pane.
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Figure 4-7 The Gradient Plot area

Gradient Plot – Depicts the current gradient that will be 
used for the run. The X-axis of the plot displays the run 
time in minutes. The X-axis scale can be adjusted by typing 
or selecting the RUN LENGTH. The left Y-axis displays 
detector(s) units of measure and the right Y-axis indicates 
the percentage of co-solvent. By default, PeakTrak 
automatically scales the left Y-axis to best display the 
detector trace. PeakTrak also sets the upper limit of the 
right Y-axis to 100%. You can override the Y-axes scales by 
selecting the MODIFY VIEW button and setting the values 
you want.  
 
To zoom into a portion of the graphic area, “pinch zoom” and 
“swipe”. To pinch zoom, place two fingers on the 
touchscreen in the graphics area, then move them apart to 
zoom in. Moving both fingers together (swiping) pans the 
display area. (A single finger touch is interpreted as a 
selection rather than as a pan function.) Alternatively, you 
can also use the ZOOM controls discussed below 
 
The gradient plot area also provides a convenient method to 
edit the gradient curve. Select and drag any of the points to 
change the shape of the curve and use the INSERT and 
DELETE POINTS buttons at the bottom of the plot area to 
insert and delete points. For complete instructions on 
defining gradient curves, see Section 4.4.3  Defining a 
Gradient.

The following controls appear in the Gradient Plot Area:
• INSERT POINT — Enables the gradient point insert 

mode. When this mode is active, select a place on the 
gradient curve to add a single point. You can then drag 
the new point to any position. Select INSERT once for 
each gradient point that must be added to the plot area.
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• DELETE POINT — Enables the gradient point delete 
mode. When this mode is active, the point nearest to the 
next point selected on the gradient curve is deleted. 
Select DELETE once for each point to be deleted from the 
plot area.

MS - Displays the current mass spectrum on PurIon systems. 
This spectrum hides the flow rate and solvent selection 
controls. Selecting the MS control again causes the 
spectrum to disappear. When the spectrum is displayed, 
touching the chromatogram at any point prior to the 
current elution time displays a spectrum at that point in 
time. The elution time corresponding to the spectrum is 
displayed under the spectrum. 

• LIVE DATA shows the current spectrum. 
• The ADD SPECTRUM button is only displayed after 

completion of the separation and saves the spectrum at 
a point for inclusion in the run report. Up to four spectra 
can be saved in a run report. The button having a 
triangle pointing down cycles through saved spectra. 

• The ± button displays the positive or negative ion 
spectrum (PurIon S and PurIon L systems only). A dot 
in the button indicates whether the positive or negative 
ionization spectrum is displayed.

• UV SPECTRUM — UV (UV-Vis on ACCQPrep SFC 
systems with a UV-Vis detector) displays the UV 
spectrum on systems. This spectrum hides the flow rate 
and solvent selection controls. Selecting the UV control 
again causes the spectrum to disappear. When the 
spectrum is displayed, touching the chromatogram at 
any point prior to the current elution time displays a 
spectrum at that point in time. The elution time corre-
sponding to the spectrum is displayed under the 
spectrum.
· LIVE DATA shows the current spectrum.
· ADD SPECTRUM saves the spectrum at a point for 

inclusion in a run report screen. Up to four spectra 
can be saved in a run report.

· The button having a triangle pointing down cycles 
through saved spectra. 

• EDIT QUEUE — Opens the QUEUE screen, which 
configures queues for use with the AutoSampler. See 
Section 3.3.5  The Queue Screen for more information.

• RUN LENGTH — Sets the length of the run. Type or 
select a length.

• SYSTEM STATUS BAR — Shows temperature and system 
pressure status:
· OVEN TEMPERATURE

· MEASURED BPR PRESSURE

· the SYSTEM PRESSURE GAUGE, which includes
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 - the MEASURED SYSTEM PRESSURE

 - the current SYSTEM PRESSURE LIMIT.
System Status Bar

Figure 4-8 The System Status Bar

The oven temperature is shown at far left beside the measured 
BPR pressure.

• In Figure 4-8 (a) it is 39.8 °C.

The measured BPR pressure shown to the left of the gauge.
• In Figure 4-8 (b) it is 100.2 BAR. 

The system pressure is shown at the left end of the pressure 
gauge. It includes the measured BPR pressure.

• In Figure 4-8 (c) it is 122.2 BAR.

The system pressure limit is derived.
• This limit equals the entered column 

PRESSURE LIMIT + the measured BPR PRESSURE

• Exceeding the system pressure limit results in a hard 
stop of the system.

Note
When setting the column parameters, the PRESSURE LIMIT
entered in the PREP SFC tab of the CONFIGURATION window 
should be the pressure limit specified by the literature included 
with the column. 

The actual maximum system pressure limit
• In Figure 4-8 (d) it is 349.9 BAR.
• It is a dynamic limit, as it depends on the measured 

BPR pressure at any moment.
• It is the lesser of these:

· the maximum-rated system pressure limit 
(6000 psi (414 BAR))

· the setting to the column PRESSURE LIMIT + 
the measured BPR pressure.

Example
column PRESSURE LIMIT of 240 BAR 
+ measured BPR pressure of 100.2 BAR 
= actual maximum system pressure limit of 340.2 BAR 
340.2 BAR is less than 414 BAR, so it becomes the maxi-
mum system pressure limit.

a b c d
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The system calculates maximum pressure using measured BPR 
pressure and not the METHOD EDITOR > BPR PRESSURE setting 
because these may differ. By using the actual measured BPR and 
making the limit dynamic based on the basis of the BPR value, 
the system prevents damage to the column while the BPR is still 
being set.

The actual pressure at column is a derived figure. It is the 
system pressure minus the measured BPR pressure.

Run Settings – 

Figure 4-9 Main: Run Settings

• COLUMN — The column used on the system. Other 
installed columns to use for purification can be selected 
from the list. Methods that are already associated with 
the selected column can be selected from the second 
level of the list.

• SAMPLE NAME — The sample name is a text entry box in 
which you can label the run. Type a unique descriptor. 
PeakTrak saves the run information under this name. 
Therefore, PeakTrak cannot accept any characters that 
are reserved by the operating system (* ? / \, etc.). 
Spaces are not allowed in the name. If you do not type a 
SAMPLE NAME, PeakTrak will generate a date/time 
stamp for the name when you select START to begin the 
run.

• FLOW RATE — The flow rate for the run. You can type it 
or select it from the list.

• COSOLVENT — The four co-solvents that have been 
configured via TOOLS > CONFIGURATION > INSTRUMENT 
CONFIGURATION (see Section 2.1  Configuration of the 
ACCQPrep SFC). Select one of the four from the list.

Run Control Buttons – Figure 4-10 shows the buttons as they 
appear when a run is not underway.

Figure 4-10Main: Run Control buttons
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• START/CONTINUE — Starts or resumes the run. After a 
run has started, this is replaced by the ISOCRATIC HOLD 
button.

• ISOCRATIC HOLD (the “pause” symbol) — Holds the 
%co-solvent at the current value while the system 
continues to operate. This is only present after the run 
has started; otherwise, the START button replaces it.

Note
Pausing the run extends the run length. While the run is in the 
paused state, you can resume the gradient by selecting START, 
or stop the run by selecting STOP FLOW. If you resume the run, 
the system continues the gradient curve from the %co-sovlent 
when the system was paused.

• STOP FLOW — Suspends the entire run. Unlike in the 
Paused state, the pump, peak detection, and fraction 
collection will not operate. While the run is stopped, you 
can abort the run by selecting RESET or TERMINATE, or 
resume the run by the selecting CONTINUE. In either 
case, the data is always saved. Using TERMINATE is the 
recommended way to abort a run because this runs 
sample probe wash and cone cleaning routines (PurIon 
systems only) to clean the system for another run. 

• TUBE ADVANCE — Advances the fraction collector to the 
next tube position. This allows you to conveniently 
collect eluant of interest in new tube. This works when 
Fraction Pooling is checked on the STACKED INJECTIONS 
or SAMPLE OPTIONS windows.

• RESET (the “rewind” symbol) — Becomes active when 
the system has completed the run, or if the run was 
stopped by selecting STOP FLOW. RESET returns you to 
the MAIN screen.
If you want to terminate the separation prematurely, TER-
MINATE is recommended. Unlike REWIND, TERMINATE does 
not modify the current method’s run length setting.

• TERMINATE (the “fast forward” symbol) — Allows you to 
jump to the next step of a run. After you have started a 
run, the system performs several steps. The first step is 
to deliver solvents using the programmed gradient for 
the entire run length. When this step is complete, the 
system enters the sample probe cleaning step. 
Selecting TERMINATE instructs the system to skip any 
remaining time in the current step and advance to the 
beginning of the next step.  
If you have stopped the run before its programmed run 
length has elapsed, the current method is modified 
using the new run length. This modified method is ready 
for the next run, or can be saved for future runs

Peak Collection Buttons – Three peak collection buttons 
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are located at the bottom of the MAIN screen.

Figure 4-11Main: Peak Collection buttons

• ALL — Collects all eluant in the fraction collection tubes. 
Detected peaks will advance to the next tube automati-
cally to maximize peak concentration and purity

• PEAKS — Collects only eluted peaks in the fraction 
collection tubes.

• NONE — Diverts all eluant to the waste port. This is 
sometimes used to divert all peaks except the peak of 
interest to waste. This action can also be accomplished 
with the INITIAL WASTE & TIME WINDOWS functions.

Peak Collection Data – Peak Collection data is displayed 
in the MAIN window after a run. You may also open a Run 
File for viewing data from previous runs (Section 4.4.7  
Viewing Runs). Selecting a test tube with the mass 
spectrum window displayed displays the mass spectrum for 
compounds collected into that tube (PurIon systems only). 
Selecting adjacent tubes allows you to determine which 
fractions may potentially contain impurities. 
The peak collection data is displayed on the left side of the 
MAIN window:

• Rack and tube information — Collected peaks are color 
coded in the rack diagram so that you can easily locate 
the peaks of interest. The tube colors correspond to the 
color bars under the peaks displayed on the 
chromatogram. If during the run more than one set of 
tube racks were filled, select NEXT RACK and PREVIOUS 
RACK to view the additional racks. The table below the 
rack diagram displays the peak data in tabular form.

• DISPLAY METHOD — Displays a summary of the method 
settings for the run. You can return to the rack and tube 
display by selecting DISPLAY RACK.

4.3.2 Method Editor The Method Editor provides the means to create and edit 
methods for chromatography runs. In the Editor, you can:

• Select a column to use.
• Set oven and preheater temperatures.
• Set flow rate and back pressure.
• Create time windows to limit the fraction collection to 

times during the run that you specify.
• Select where eluant will be collected.
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• View and edit the current gradient.
• Set detector settings.
• Save methods to Run Files for later retrieval.

To open the window, select METHOD EDITOR from the Peak Trak 
menu at the top of the screen.

Figure 4-12The Method Editor window 

Button bar – Provides buttons to work with method files 
and display column data.

Figure 4-13Method Editor button bar

• NEW (icon) — Opens a new method file using the default 
method settings for the selected column.

• OPEN (icon) — Opens a method file stored on the 
system’s internal hard drive.

• SAVE (icon) — Saves any modifications to the current 
method file. If you attempt to save modifications to a 
default method file, the FILES window opens instead and 
allows you to rename the file to preserve the default 
method. 

• SAVE AS — Opens the FILES window. From this window 
you can rename the current method and save it on the 
system’s internal storage.
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• EXIT — Closes the METHOD EDITOR and return to the 
MAIN WINDOW.

• COLUMN DATA — Opens the COLUMN DATA window. 
This window reports information about the column 
selected on the MAIN screen. The COLUMN DATA button 
is found at the top right corner of the window.

Run Settings – 

Figure 4-14Method Editor: Run Settings

• COLUMN — The name of the currently selected column is 
displayed. If a Column Selector Valve Module is 
installed, this selects the column used for the current 
separation. 

• SAMPLE NAME — The sample name is a text entry box in 
which you can label the run. Type a unique descriptor. 
PeakTrak saves the run information under this name. 
Therefore, PeakTrak cannot accept any characters that 
are reserved by the operating system (* ? / \, etc.). A 
space can’t be used in the sample name. If you do not 
type a Sample Name, PeakTrak generates a date/time 
stamp for the name when you select START to begin the 
run.

• FLOW RATE — The flow rate for the run. You can type it 
or select it from the list.When you use the Teledyne 
LABS default column methods, the system sets the flow 
rate to the configured flow rate of the column.

• EQUILIBRATION volume — Type or select the volume of 
solvent that is pumped through the column and out the 
waste port before the sample is introduced. Data is not 
collected while this volume is being pumped. 

• PREHEATER — Controls the oven and preheater 
temperature. This cannot be changed once a method is 
in use.

• BPR PRESSURE — Sets a pressure limit (between 100 
and 160 BAR) for the back pressure regulator (BPR).
· Controlling the pressure of the mobile phase—

including back pressure—is important because 
pressure affects the phase’s density, which in turn 
affects the retention factor, peak resolution, and 
consistency between runs.

· The BPR PRESSURE limit, when combined with the 
column PRESSURE LIMIT (Section 2.6.5), sets the 
system pressure limit. Were the system to exceed its 
pressure limit, a hard stop would occur.
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· The entry to BPR PRESSURE does not necessarily 
dictate at-column pressure because, at any given 
moment, the actual back pressure may not have yet 
reached the BPR PRESSURE limit.

· The BPR PRESSURE setting to a method cannot be 
changed while the method is in use.

• INITIAL WASTE & TIME WINDOWS — Opens TIME 
WINDOWS, a window from which you can view and 
modify waste and define time windows. Time windows 
can limit the fraction collection to specific time 
durations of the run. See Section 4.4.1  Editing a 
Method for more information.

Time Windows – 
• INITIAL WASTE - The volume of eluant that is allowed to 

pass through the column to the waste port after the 
sample is injected. After this volume has been diverted, 
the system is ready to collect peak or all fluids in the 
collection tubes. This feature conserves collection tubes 
by diverting all fluids until the first peak is expected. 
 
Time Windows Section - All times are relative to start 
of the run, just following the sample injection. To use 
time windows, check a box to activate a row, then enter 
START and END times. You can define up to six time 
windows.

• PEAK COLLECTION - Describes how peak states limit 
when fluid is collected.
· Peaks - Instructs the module to collect fluid only 

when the time window is active and a peak is 
present.

· All - Instructs the module to collect all fluid during 
the time window. Detected peaks will still trigger 
tube advances. During stacked injections, all fluid is 
collected during the time window regardless of peaks.

RUN NOTES — Provides a text entry box into which you can enter 
comments or notes for the run. These comments are saved with 
the run and appear in TXT and PDF reports. Column identifi-
cation information is automatically placed in this box.

Gradient Plot Area – Depicts the current gradient profile 
that will be used for the run. The X-axis of the plot displays 
the run time in minutes. The X-axis scale can be adjusted 
by typing or selecting the RUN LENGTH. The left Y-axis 
displays absorbance units, and the right Y-axis indicates 
the percentage of co-solvent. 
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The gradient plot area also provides a convenient method to 
edit the gradient curve. You can select and drag any of the 
points to change the shape of the curve, or use the buttons 
at the bottom of the plot area to insert and delete points. To 
zoom into a portion of the graphic area, use “pinch zoom” 
and “swipe.” Pinch zoom by placing two fingers on the 
touchscreen in the graphics area, then move them apart to 
zoom. Once zoomed in, moving both fingers pans the display 
area. (A single finger touch is interpreted as a selection 
rather than as a pan function.) 
 
The following controls appear in the Gradient Plot Area:

• INSERT POINT — Enables the gradient point insert 
mode. When this mode is active, select a place on the 
gradient curve to add a single point. You can then drag 
the new point to any position. Select INSERT once for 
each gradient point that must be added to the plot area.

• DELETE POINT — Enables the gradient point delete 
mode. When this mode is active, the system deletes the 
point nearest the next point selected on the gradient 
curve. Select DELETE once for each point that must be 
deleted from the plot area.

• RUN LENGTH — Sets the length of the run. Type or 
select a length. 

Note
Changing the run length changes the scale of the X-axis on the 
gradient. Points that define the gradient are automatically 
scaled to fit the new run length.

The RUN VIEWER also has a plot area with its own controls. 
See Section 4.4.7  Viewing Runs for a discussion of these 
controls.

Solvent and Gradient Options – 

Figure 4-15Method Editor: Solvent and Gradient options

• COSOLVENT — The solvents listed are those defined by 
the CONFIGURATION settings. You can program mid-run 
co-solvent changes by selecting EDIT GRADIENT to open 
the GRADIENT TABLE.

• EDIT GRADIENT — This table changes the FLOW RATE at 
the time points on the gradient plot area. Select EDIT 
GRADIENT to toggle the gradient table open or closed. 
After the table is opened, add or delete time points, or 
select a field to highlight it and make the row editable. 
Changes that you make to the table are reflected in the 
gradient plot area. 
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For complete instructions on defining gradient curves, 
see Section 4.4.3  Defining a Gradient.

Figure 4-16Gradient Table

· INSERT POINT — Adds a time point before the point 
whose row is highlighted on the table. The new point 
appears at the same location as the highlighted row’s 
point. You can move it along the X-axis by changing 
the LENGTH entry. 

· DELETE POINT – Removes the highlighted row and its 
associated point from the table. You cannot delete 
the initial point. There must be at least two points to 
define a gradient. The system automatically updates 
the RUN LENGTH setting or scales the other points 
when you change the number of points and their 
duration on the curve. To close the GRADIENT TABLE, 
select the EDIT GRADIENT button. See Section 4.4.3  
Defining a Gradient.

· COSOLVENT – A cosolvent that have been entered on 
the CONFIGURATION window > INSTRUMENT CONFIG-
URATION tab.

· FLOW RATE – The flow rate in mL per minute. A 
change in flow rate at a point is shown in the 
gradient plot area as a vertical line through and a 
callout at the previous point.

Note
Any changes to the flow rate in the gradient table occur almost 
immediately at that point. There is not a gradual change to the 
new set flow rate over the time period, unlike the gradual 
change of %B composition in the gradient table.

· LENGTH, MIN – The number of minutes or column 
volumes from the previous time point, as viewed 
along the X-axis of the gradient plot area.

· %B – The percentage of solvent B. Adjusting a value 
on a row also moves its point along the Y-axis.

Peak Collection – Use the PEAK COLLECTION buttons to set 
the collection mode.
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Figure 4-17Method Editor: Peak Collection and Tube 
Volume

• ALL — Collects all fluids in the fraction collection tubes 
during a run.

• PEAKS — Collects only eluted peaks in the fraction 
collection tubes during a run.

• NONE — Diverts all fluids during a run to the waste 
port.

See Section 4.4.1  Editing a Method for a more detailed dis-
cussion of peak collection.
Tube Volume – The tube volume for collected fluids. This 
volume can be the default maximum volume for that tube size 
(Max option) as entered in the CONFIGURATION window, or a 
method-specific volume less than the capacity defined by the 
CONFIGURATION window. 

Note
The actual fraction size may be less if a newly detected peak 
causes a tube change or if you select TUBE ADVANCE button.

• PEAK — The volume to be collected in each tube when 
the system detects a peak. Type the volume or select it 
the list.

• NON-PEAK — The volume to be collected in each tube 
when peaks are not detected. Type the volume or select 
it the list.
· Allows you to conserve tubes without diverting 

non-peak elute to waste.
· Settings to NON-PEAK are ignored when the peak 

collection mode is set to Peaks or None.
• NO INJECT/ NO COLLECT — Runs a method without 

injection and without collecting peaks. Useful for setting 
up column conditioning or washing methods for using in 
the queue.

Peak Detection – This section of METHOD EDITOR provides 
peak detection options. When a detection method is 
selected, its DETAILS button opens a window (Figure 4-18) 
on which you can modify that detection method’s settings. 
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Note
You can select up to four peak detection options on the 
ACCQPrep systems,. If more than one option is selected, such 
as 1 with 2, the system considers a peak to be present when 
an option is true (a logical OR).

Figure 4-18A Peak Detection settings window

All enabled detection methods are displayed on the chro-
matogram. Options and settings for the ACCQPrep SFC system 
are described below.

Wavelength Peak Detection • 1 and 2 (wavelength 1 and 2) — Instruct the system to 
use and allow you to configure primary and secondary 
wavelength detection. 2 is set to monitor (displayed but 
not used for peak detection and cutting) by default. 
When checked, type or select the peak detection 
wavelength in nanometers, then select DETAILS to 
configure additional settings:

Wavelength Peak Detection 
Details

· SIGNAL GAIN – Modifies the gain. Use this to scale 
the detector signal.

· SLOPE BASED — When selected, enables slope-based 
peak detection. Peaks are recorded if the slope 
algorithm detects a peak similar to the average PEAK 
WIDTH. Select the average peak width setting. Peak 
widths are measured at the baseline. The slope 
detector typically detects peak widths ranging from 
about 0.2 to 2 times the peak width setting. For 
example, if you entered a peak width of 1 minute, the 
range would be 12 seconds to 2 minutes. For best 
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operation, the peak width should be set to just over 
the average peak width being separated. For 
instance, if the average peak width is 45 seconds, 
enter a peak width of 1 minute. Sometimes very 
small peaks need a larger peak width setting since 
their small height results in a smaller slope than 
larger peaks of the same width. For most SFC, 
1 minute is a good starting point for a peak width.

· THRESHOLD — When selected, enables threshold 
peak detection. Peaks then start when the detector 
signal exceeds the programmed value. The peak ends 
when the detector signal drops to .01 AU below the 
programmed value. This reduces the potential of 
multiple peaks if a noisy signal oscillates around the 
threshold value.

Note
If both Slope and Threshold peak detection methods are 
checked, the system considers a peak to be present when any 
one condition is met. This logical OR operator means that the 
system will cut a peak when either the Slope condition is true, 
or when the Threshold condition is true.

· MONITOR — When selected, instructs the system to 
only use the detection source as a monitor. The 
detection source is then displayed as a trace on the 
gradient plot area, but is not used to cut peaks.

All Wavelength Peak 
Detection

• ALL WAVELENGTH DETECTION — When selected, detects 
peaks within a user-selected range of wavelengths. 
Select its DETAILS button to configure additional 
settings. These settings include the SIGNAL GAIN, SLOPE 
BASED, and MONITOR options described earlier for 1 
and 2. Other DETAILS settings are unique to ALL 
WAVELENGTH Detection:
· PEAK WIDTH — Determines solvent absorbance 

suppression. Peaks that are twice the peak width are 
deemed to be solvent or other baseline drift, and their 
absorbance spectra are subtracted as assumed 
baseline spectra. Additionally, you can type or select 
the minimum and maximum wavelengths limits in 
nanometers. Doing so eliminates areas of little 
spectral information from the all wavelength 
detection signal, resulting in a stronger signal.

All Wavelength Details · MINIMUM (MAXIMUM) That is, the minimum and 
maximum wavelength detected. Set this to avoid 
detection of certain wavelengths—for example, those 
associated with unwanted compounds.

ELS Peak Detector • ELS Detector — When selected, enables the evaporative 
light scattering (ELS) detector on an ACCQPrep system. 
Select its DETAILS button to configure additional 
settings:
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ELS Detector Details · SENSITIVITY - Can be selected as NORMAL to keep 
largest peaks on scale or HIGH to detect small peaks.  
The default setting is HIGH to ensure most 
compounds are detected.

· SIGNAL GAIN – Modifies the gain to scale the detector 
signal.

· SLOPE BASED AND THRESHOLD – Refer to these 
features described earlier for 1 and 2.

· DRIFT TUBE TEMPERATURE – The default settings is 
60 °C for normal phase default methods. This setting 
may be adjusted from 30 to 90 °C, but is limited to a 
range of 5 °C below and 60 °C above the ambient 
temperature.
The drift tube temperature must be high enough to 
evaporate the solvent aerosol entering the drift tube. If 
the temperature is not high enough, unevaporated sol-
vent may form a fog that condenses on the detection 
system preventing detection of the compounds. This 
can be corrected by using TOOLS > MANUAL CONTROL > 
ELSD ON to turn on the flow of gas through the drift 
tube without liquid. Temperatures that are too high 
can cause semivolatile compounds to vaporize and 
become undetectable.

Mass Spectrometer Peak 
Detection

• MASS SPECTROMETER – When selected, monitors or 
detects compounds with a PurIon mass spectrometer 
system (PurIon systems only). Mass-directed peak 
detection can be set for up to 6 masses or 5 masses and 
1 range.

THRESHOLD – Selects the START and END signal inten-
sity ratios for directing fraction collection. Selecting 
THRESHOLD deselects MONITOR.
This limits fraction collection for peaks that have tail-
ing tendencies. Such peak tails may cause collection of 
many fractions that contain a very small amount of 
compound. Consequently, MS detection can lead to 
compound tailing that causes excessive fraction collec-
tion.
Usually, the default THRESHOLD settings control com-
pound tailing adequately. However, adjusting the 
START or END thresholds to define an asymmetric 
threshold may be required to improve peak cutting to 
minimizes collection of such fractions and speed the 
collection process.

· START threshold – The multiple of the mass 
spectrometer signal's noise baseline level at which 
peak collection starts. Setting it lower can allow the 
software to start collecting compound more quickly, 
and it may slightly improve recovery while 
minimizing the number of collected fractions. The 
noise level is measured at the first column volume.
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· END threshold – The percentage of the maximum 
peak height of the current peak at which detection 
stops and collection ends. For example, entering 20% 
ends collection at 20% of the peak height. Setting a 
percentage of peak height can allow proper collection 
of both large and small peaks. Setting this to 0% 
instructs peak collection to use the START noise 
threshold.

· MONITOR – When selected, prevents fractionation 
based on the mass spectrometer signal.

· TERMINATE ON TARGET – When selected, stops the 
run after all mass spectrometer detection ions have 
been detected.

· DETECTION IONs – Sets ions for detection or to be 
monitored. Up to four single ions may be chosen, or a 
range of ions and up to three single ions may be 
selected. On PurIon S and PurIon L systems, 
detected ions may be a mixture of positive and 
negative ions.

· SPECTRUM START/END – (PurIon S and PurIon L 
systems only)

· POSITIVE IONIZATION – Selects positive ion spectrum 
(PurIon S and PurIon L systems only). Selecting 
POSITIVE IONIZATION deselects NEGATIVE IONIZATION.

· NEGATIVE IONIZATIOn – Selects positive ion spectrum 
(PurIon S and PurIon L systems only). Selecting 
NEGATIVE IONIZATION deselects POSITIVE IONIZATION.

· ION SETTINGS – Sets ionization parameters to 
enhance detection of molecular ion peaks.

· PURION LOADING – Sets the mass load (High, 
Medium, or Low); that is, the quantity of the carrier 
flow rate that is sent to the mass spectrometer (MS).
High: 20 μl/min
Medium: 6 μl/min
Low: 1.467 μl/min

Setting the mass load too low will result in significant sig-
nal delays, while setting it too high will result in poor sig-
nal and clog the MS with excess sample.
The PurIon MS doesn't have a defined carrier fluid split 
ratio; instead, it uses an active splitter valve assembly that 
portions off a specific, programmable volume of the system 
flow. Portion volume is set independently of the carrier 
fluid flow rate (always 0.2 mL/min). The effective split 
ratio is system flow rate ÷ split flow rate. Some examples:

At a system flow rate of 20 ml/min, the split ratios are 
1000:1, 3333:1, and 13633:1. (That is, 
20 ml ÷ 20, 6, and 1.467 μl/min, respectively.)
At a system flow rate of 100 ml/min, the split ratios are 
5000:1, 16666:1, and 68166:1 (That is, 
1000 ml ÷ 20, 6, and 1.467 μl/min, respectively.)
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· MS Detection Start/End – Sets the start and end 
times at which the MRA valve is active during the 
method. This avoids salts and other contaminates at 
the start of a run and prevents unwanted compound 
from being sent to the mass spectrometer during a 
column wash.

Note
If the MS is not active during the start of the run, the MRA 
valve will not be active during equilibration or any pre-run sam-
ple loading when using the sample loading pump.

Purity Measure Peak 
Detection

• PURITY MEASURE — When checked, displays a ratio of 
the selected wavelengths if two absorbance wavelengths 
are used. Select its DETAILS button to configure 
additional settings:

Purity Measure Details · SHOW RATIO — Displays a ratio of the selected 
wavelengths when two absorbance wavelengths are 
used. The ratio trace is often a useful indicator of 
purity. 

· SHOW SPECTRAL PURITY — Measures purity by using 
a comparison of the entire UV-spectra measured at 
differing times as a purity measurement. It also 
allows fractionation based on spectral purity.

· SPECTRAL PURITY DETECTION — Allows fractionation 
based on spectral purity.

· THRESHOLD — Works similarly to the THRESHOLD 
setting for 1 and 2. Checking SPECTRAL PURITY 
DETECTION makes this THRESHOLD option available.

4.3.3 Column Data The COLUMN DATA window reports information about the column 
installed in the system. This information includes the “Number 
of times used,” “First Used On,” and “Last Used On” information, 
which can help you determine when the column should be 
replaced. The “Last Fluid Used” helps you determine if any 
solvent remaining in the column will be miscible with the solvent 
currently used in the system. To view the COLUMN DATA window, 
open the METHOD EDITOR, then select the COLUMN DATA button.

4.3.4 Files The FILES window is modal. That is, its function and features 
change according to the command used to open the window. 
Menu commands such as FILE > OPEN and SAVE METHOD AS and 
selecting the OPEN and SAVE AS buttons open this window. Use 
FILES to browse the system’s files and folders. The following con-
trols appear on the window:

• Current Path — The top-left corner of the window 
displays the path (current folder). As you browse 
through the files, the path updates. You can select the 
folder names to return to upper folder levels.

• File and Folder Operation buttons:
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· COPY — Copies a highlighted file to the system’s 
clipboard memory.

· PASTE — Pastes a file from the clipboard memory. If 
the file of the same name is already in the current 
folder, the system will ignore PASTE to prevent the 
original file from being overwritten.

· DELETE — Deletes a highlighted file or a folder and 
its contents.

· NEW FOLDER (icon) — Creates and names a new 
folder.

· UP (icon) — Allows you to browse the contents of the 
next-higher folder level.

· SEARCH — Finds matching file names when you 
enter a keyword and select SEARCH. Select CLEAR 
SEARCH to clear the results.

• File Management options —
· Select COPY FILES TO FLASH DRIVE or MOVE FILES TO 

FLASH DRIVE to create archive copies (PDF or Text) of 
the files on a connected flash drive. Select DELETE BY 
AGE to specify an age limit beyond which to delete 
files from the internal hard drive.

· FILE/FOLDER info scroll box — Lists the contents of 
the current folder. The contents can be sorted by 
selecting the column headings.

· FILE TYPE — When shown, limits the display to a 
certain type of files. Select the file type from the list.

· FILE NAME — A entry box used to identify the 
currently selected (highlighted) file or folder when 
browsing and opening files. When using SAVE AS, use 
this box to name the file.

· OPEN/SAVE/DELETE — Performs the listed action.
· LOAD PREVIOUS RUN FROM DETECTED RACK — 

Appears when using FILE > OPEN. Selecting this 
option causes the system to read the RFID tag on a 
single rack and displays the last RUN FILE collected 
on the detected rack on this instrument. This feature 
is useful you are unsure of the rack’s contents.

Note
The rack must be placed in the left position in the instrument. 
If the AutoSampler is present, the rack must still be placed 
inside the ACCQPrep SFC system.

· CANCEL — Closes the window without saving or 
opening the file.
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4.3.5 Set Data Path FILE > SET DATA PATH opens the SET DATA PATH window. Use 
this window to select a default folder for the current user. After 
selecting a folder, file operations such as saving or opening files 
will use the directory you selected.
The SET DATA PATH primarily is used with the USER MAN-
AGEMENT feature. USER MANAGEMENT automatically creates a 
folder for each user. When using the system, set the data path to 
your folder or a subfolder within. Each user has a different data 
path. The window contains the following controls:

• CURRENT DATA PATH — The top-left corner of the 
window displays the path (current folder). As you 
browse through the files, the path updates.

• NEW — Adds and allows you to name a subfolder within 
the currently selected folder.

• DELETE — Deletes the selected folder.
• Folder selection box — Lists the available folders; select 

them by checking their boxes.
• OK — Saves your selection as the data path and closes 

the window.
• CANCEL — Closes the window without changing the 

data path.

4.3.6 MS Method 
Development 

(The MS METHOD DEVELOPMENT window is available on PurIon 
equipped systems only).

MS > Method Development MS METHOD DEVELOPMENT provides a way to test and verify ion-
ization conditions for a compound. METHOD DEVELOPMENT is not 
available from a remote connection.

Figure 4-19Mass Spectrometer Method Development 
window 

• POLARITY — On the PurIon system, this changes the 
probe polarity between positive and negative ionization. 
On PurIon S and PurIon L systems, this button toggles 
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the displayed mass spectrum between positive and 
negative ionization.

• ION SETTINGS — Allows selection of different ion 
settings to maximize the intensity of the desired 
molecular ion. The factory selections include “Robust”, 
for compounds that do not easily ionize. “Typical” works 
well for most compounds. The “Fragile” setting is used 
for those compounds that are delicate or easily 
fragment. User defined ion settings may also be loaded.

• ION FINDER—Opens the ION FINDER window. The Ion 
Finder identifies potential adducts, fragments, and 
multiply charged species of the compound of interest 
when the compound of interest does not show up in the 
spectrum graph. Such ions can then be used to detect 
the compound of interest. See Section 4.3.7 Ion Finder.

• DETECTION IONS—After a spectrum is collected, 
selecting a peak adds that ion to this control. Alter-
nately, masses can be entered using a keypad control.

• CLEAR IONS—clears the last value entered into the 
Detection Ions control.

• MASS SPECTRUM GRAPH—this displays the mass 
spectrum. There are two mass spectra displayed. The 
spectrum depicted in blue shows what the PurIon is 
currently detecting. The red spectrum depicts the 
largest peaks detected. The red spectrum is reset after 
injecting a sample. To inject a sample, move the PurIon 
injection valve to the “inject Sample position” Inject the 
sample (>20 uL) and move the valve to the “Scan Mass” 
position.

Note
Only use 22 gauge square tip needles (PN 29-9001-911) to 
avoid scratching the internal surfaces of the injection valve! Fil-
ter the sample with a 0.45 μ filter to avoid clogging the PurIon 
tubing and probe capillary. Sample concentration should be 
less than 20 μg/mL.

• MODIFY VIEW—Sets the displayed range of the mass 
spectrum. The PurIon system still collects the entire 
mass range even when the range is set within than the 
minimum and maximum values allowed for the 
spectrometer. Values can range from 10 to 1200 Da 
(PurIon or PurIon S) or 2000 Da (PurIon L). Changing 
the mass range defined by these controls may cause the 
Y-axis (ion count) scaling to change on the basis of the 
tallest peak within the range. The display only labels 
the m/z for the 10 most prevalent ions currently 
displayed.  Formatting the graph to a narrower range 
causes the system to relabel the ions to identify ions 
that may not have been intense enough to be labeled on 
the broader range graph.
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• SPECTRUM NAME— The file name for the mass spectrum 
is needed only if you want to save the mass spectrum to 
a file for later viewing.

• SAVE DATA— Saves the mass spectral data to the 
internal hard drive.

• SAVE AS PDF— Saves the displayed spectrum on either 
a USB drive or a remote computer’s hard drive. The file 
name is the same as the spectrum name except for the 
.pdf extension. PeakTrak displays a file download 
window so you can select a location and change the file 
name.

• FLUID INTERFACE PRESSURE — The carrier solvent 
pressure, displayed in a ribbon gauge. If the pressure 
approaches the level of the red line, the system is 
clogged and should be cleaned to allow proper operation.

4.3.7 Ion Finder (The ION FINDER window is available on PurIon equipped 
systems only).

MS > MS Method 
Development > Ion Finder

The Ion Finder identifies potential adducts and fragments of the 
compound of interest when the compound of interest does not 
show up in the spectrum graph. It is useful when working with 
large molecules.
After entering a molecular weight, the Ion Finder algorithm 
looks for masses in the spectrum that match loss of various frag-
ments, adducts, and multiply charged ion species. It can detect 
and report multimers, solvent adducts, and charge carriers that 
replace protons such as sodium and potassium. It can detect pos-
itive, negative, and multiply charged ions.
After ions are detected, you can select any such ions that corre-
spond to the mass of interest and use them for detection.

Note
The Ion Finder has no knowledge of the compound, so some 
items in the Detection Ion list may not be associated with or 
even possible for the compound to be purified. Or, they may 
only be part of the injection or carrier solvent.

The Ion Finder only acts on the ten most intense peaks in the 
display. When impurities are present, some of the desired com-
pounds’ mass peaks may not be noted by the finder. In that case, 
rescaling the mass can eliminate unwanted intense peaks (pos-
sibly due to impurities) and allow detection of the desired com-
pound.
To use the Ion Finder:

1. Use the METHOD DEVELOPMENT window (MS > METHOD 
DEVELOPMENT) to inject a sample.

2. Select POLARITY and ION SETTINGS. Changing the ION SET-
TINGS changes the ions seen. Remember that ION SETTINGS 
choices do not transfer to the detection options for the mass 
spectrometer in the METHOD EDITOR—the ion settings that 
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gave a good result in the MS METHOD DEVELOPMENT win-
dow should be chosen.

3. Select ION FINDER. The ION FINDER window opens to dis-
play a list potential adducts and fragments detected in the 
compound of interest. Due to isotopes, multiple peaks near 
one another may be found. (For example, 546, 547, 818, 
and 819. See Figure 4-20.)

4. Optionally, select the checkbox next to a listed ion to add it 
to the ions to be detected.

Figure 4-20The Ion Finder window

DESIRED MASS – The molecular weight of your compound, 
rounded to the nearest integer.
DETECTED IONS – The list of ions to be detected.
DETECTION ION – The list of possible adducts or fragments based 
on the value entered in the desired mass control and detected by 
the system. Checking one of these values adds it to the 
DETECTED IONS list.

4.3.8 MS Manual Control (The MS MANUAL CONTROL window is available on PurIon 
equipped systems only).

MS > Manual Control MS MANUAL CONTROL allows the fluid interface carrier solvent 
pump to be run for priming and to purge the carrier solvent. This 
window can also be used for troubleshooting. 
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Figure 4-21Mass Spectrometer Manual Control window 

• START CARRIER PUMP — Turns the carrier pump on for 
priming or to replace one carrier solvent with another 
one. A purge is complete in ~5 minutes. This changes to 
read STOP CARRIER PUMP when the pump is running. 
 
To prime the pump, open the priming valve on the fluid 
interface counterclockwise. Use the 5 mL Luer lock 
syringe provided with the accessory kit to draw liquid 
into the pump. Repeat this procedure once more to 
completely fill or purge the line from the carrier solvent 
reservoir to the priming valve. Make sure the priming 
valve is tightly shut after priming the system.

• STOP CARRIER PUMP — Stops the carrier pump. This 
changes to read START CARRIER PUMP after the pump is 
stopped.

• OPERATE SPLITTER VALVE — Runs the splitter valve to 
verify operation.

• FLUID INTERFACE PRESSURE — Displays the carrier 
solvent pressure in a ribbon gauge. If the pressure 
approaches the level of the red line, the system is 
clogged and should be cleaned to allow good response.

• CLOSE — Closes the window and stops the carrier pump 
if it is running.

4.3.9 MS Ionization Settings (The MS IONIZATION SETTINGS window is available on PurIon 
equipped systems only).

MS > Ionization Settings The MS IONIZATION SETTINGS improve the ionization of a par-
ticular compound by reducing fragmentation or adduct for-
mation.
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Figure 4-22Mass Spectrometer Ionization Settings window 

• MASS SPECTRUM GRAPH — Displays the mass spectrum. 
There are two mass spectra displayed. Blue displays the 
maximum of the current injection. Red displays the 
maximum of the previous injection for comparison. 
When a new injection is performed, the blue spectrum 
replaces the red spectrum, and a new blue spectrum is 
started. To inject a sample, move the PurIon injection 
valve to the “Inject Sample” position. 
 
Inject the sample (20 uL) and move the valve to the 
“Scan Mass” position.

Note
Only use 22 gauge square tip needles (PN 29-9001-911) to 
avoid scratching the internal surfaces of the injection valve. Fil-
ter the sample with a 0.45 µ filter to avoid clogging the PurIon 
tubing and probe capillary. Sample concentration should be 
less than 20 µg/mL.

• POLARITY — Switches the mass spectrometer between 
positive and negative polarity.

Note
The PurIon S and L systems capture both polarities. The set-
ting changes which polarity is displayed.

• FORMAT GRAPH — Sets the displayed range of the mass 
spectrum. The PurIon system still collects the entire 
mass range even when the range is set within than the 
minimum and maximum values allowed for the 
spectrometer. Values can range from 50 to 1200 Da 
(PurIon and PurIon S) or 2000 Da (PurIon L). Changing 
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the mass range defined by these controls may cause the 
Y-axis (ion count) scaling to change on the basis of the 
tallest peak within the range.

• FLUID INTERFACE PRESSURE — Displays the carrier 
solvent pressure in a ribbon gauge. If the pressure 
approaches the level of the red line, the system is 
clogged and should be cleaned to allow proper operation.

• ION SETTINGS — Allows selection of different ion 
settings to maximize the intensity of the desired 
molecular ion. The factory selections include “Robust” 
for compounds that do not easily ionize. “Typical” works 
well for most compounds. The “Fragile” setting is used 
for those compounds that are delicate or easily 
fragment. User-defined settings may also be loaded.

• MAKE CHANGES — Allows you to change the settings to 
improve the intensity of an ion.

• SAVE — Saves changes to an existing ion settings file.
• SAVE AS — Save changes and create a new ion settings 

file. This new file can be selected in ionization settings 
or method development. Additionally, this file can also 
be selected when setting up a separation run.

• FACTORY SETTINGS — Restore the “typical”, “Robust”, 
and Fragile” ion settings to the factory default values.

• PROBE — The probe nebulizes and ionizes the sample. 
There is a choice of ESI (electrospray interface) or APCI 
(atmospheric pressure chemical ionization) probes. The 
software changes the labels on the control to reflect the 
probe installed in the mass spectrometer.

• GAS TEMP — The temperature of the nebulization gas 
for the probe. Lower temperatures are used for more 
delicate, heat labile compounds. The temperature is set 
to quickly evaporate the carrier solvent. (Note: PurIon S 
and PurIon L systems display a single temperature for 
both positive and negative ionization).

• VOLTAGE (Current) — Displays a voltage setting (ESI 
probes) or current value (APCI probes). Lower values 
are used for more delicate compounds. 
 
The capillary is heated to complete the evaporation of 
solvent. It also carries a voltage; lower voltages are used 
for more delicate compounds.

• SOURCE VOLTAGE — The source voltage settings have 
the greatest effect on fragmentation. Higher values 
induce more fragmentation but also reduce adduct 
formation.

• OFFSET — The voltage applied to all masses. Large 
values tend to increase fragmentation but reduce adduct 
formation.
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• SPAN — Span voltage defines an increased voltage 
applied as the mass increases. As with the offset, larger 
values increase fragmentation.

• CLOSE — Closes the window.

4.3.10 Manual Control Manual Control can assist with method development, mainte-
nance of the system plumbing, and system troubleshooting. The 
MANUAL CONTROL window can be opened by selecting 
TOOLS > MANUAL CONTROL from the PEAKTRAK menu.

Figure 4-23 Manual Control Settings - Quick Cleaning

MANUAL CONTROL window options:
• COLUMN – The column that is in the flow path. There is 

always such a column. Choose one from the list box, 
making sure the co-solvent is compatible with the 
chosen column.

• SAMPLE LOOP – Settings made here allow fluid going 
through the injection valve to either BYPASS or go 
THROUGH (the) SAMPLE LOOP.

• COSOLVENT – Allows selection of the solvent that is 
pumped during manual pump operation.

• PERCENT COSOLVENT – The mixture percentage. 
Type it or select it from the list box.

• FLOW RATE – The pump’s flow rate in mL/min. Type it or 
select it from the list box. The minimum flow rate 
available for manual control is lower than that on the 
METHOD EDITOR window. This is because some columns 
may need to be onboarded with that lower flow rate.

• COLLECTION – The destination for fluid. By default, fluid 
is pumped to the waste port during manual control. 
Alternatively, solvent can be collected in a fraction valve 
position or to a tube that you select from the list.
This feature can be useful when trying to recover a com-
pound that has precipitated or “crashed” somewhere in the 
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fluid path. In that case, you can collect or flush the column 
in the MANUAL CONTROL window, then select a destination 
to send the eluate (Section 4.4.8). Afterwards, evaporate 
the eluant and rerun the sample.

• PERCENT XX% CO-SOLVENT – The percentage of 
co-solvent pumped with CO2.

• STOP – Stops the pump. This button is only available 
while the pump is running.

The raw lamp energy display can be used to verify flow cell clean-
liness. If the energy is low, it can be monitored while pumping a 
solvent to clean the flow cell (5.4  Flow Cell Cleaning). Select 
CLOSE MANUAL CONTROL to close the window. 

4.3.11 Automation Manual 
Control

This opens the AUTOMATION MANUAL CONTROL window, which 
can be useful in flushing different portions of the AutoInjector/ 
AutoSampler flow paths by choosing the flow path, fluid source, 
and the amount of fluid to be pumped by the AutoInjector.  It can 
also be used to prime the wash station.

Tools > Automation Wash 
Control

Figure 4-24The Automation Manual Control window

To prime the wash station:
1. Ensure that the wash station supply line is placed into a 

suitable solvent (typically the strong chromatographic sol-
vent) and that the waste line is routed to a suitable con-
tainer.

2. Select START WASH to begin the priming process.  Be sure 
that the wash solvent is pumped into the center portion of 
the wash station and that the fluid drains into the overflow 
drain when the station is full.

3. After the wash station is primed, select STOP WASH.

4.3.12 Set Administrator 
Password

This window, opened by selecting TOOLS > SET ADMINISTRATOR 
PASSWORD from the PeakTrak menu, is used to enter and change 
the system password.
To enter or change a password:

1. Type the password. The factory default password is 
“accqprep”.

2. Type the new password.
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3. Type the password again to verify your entry.
4. Make a record of the password and store it in a safe place.
5. Select OK to save your settings and close the window.

The following menu commands access administrative areas of 
PeakTrak and may require a password:

• TOOLS > USER MANAGEMENT

• HELP > SERVICE

• TOOLS > SET ADMINISTRATOR PASSWORD. This protects 
the current password.

Password protection is disabled when the administrator 
password is left blank; then, all users can use the commands 
listed above. Furthermore, non-administrative users have their 
own passwords. Any user can have access to administrative 
areas if given administrative permissions in the USER MAN-
AGEMENT window. (see Section 4.2.4  Tools: User Management).

4.4 Examples of PeakTrak 
actions

This section provides instructions for typical PeakTrak tasks 
such as:

• editing a method 
• alternative ways to create method files
• editing a default method
• defining a gradient
• real-time gradient editing
• monitoring the purity measure
• viewing runs
• manual control of the ACCQPrep SFC system

4.4.1 Editing a Method Editing a method allows you to tailor the operation of the 
ACCQPrep SFC system to best separate or purify the compounds 
of interest.
PeakTrak has two types of method settings: basic and advanced.

Basic Method Settings The basic settings allow you to control the %co-solvent gradient 
mix, flow rate, solvents, and run length. These settings are part 
of the MAIN screen (Section 4.3.1), and are the most frequently 
changed settings when developing or improving purification 
methods.
The %cosolvent gradient mix and run length are shown on the 
plot area. Refer to Section 4.4.3  Defining a Gradient for details.
The other settings are: 

• FLOW RATE — This defaults to the value created when 
setting up the SFC column but can be changed for each 
separation as required. Note that the minimum flow 
rate available on the MANUAL CONTROL window may be 
lower than this rate to aid in loading certain columns.

• COSOLVENT — The solvents listed are those defined by 
the CONFIGURATION window.
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Advanced Method Settings The METHOD EDITOR window (Section 4.2.2) gives you access to 
advanced settings such as EQUILIBRATION volume, INITIAL 
WASTE, PEAK DETECTION, and PEAK COLLECTION mode.

• EQUILIBRATION volume — Column equilibration is 
optional, but you may find that separations are more 
effective if the column is equilibrated before injecting 
the sample.

• INITIAL WASTE & TIME WINDOWS — The initial waste 
diverts a user-determined volume to the waste port until 
the eluant is about to be collected. At the start of a run, 
the internal solvent lines hold some solvent from the 
previous run. This volume can be diverted to waste, 
along with the anticipated volume of fluid that will pass 
through the column before a compound of interest will 
elute. 

Time windows can limit the fraction collection to specific 
time durations of the run. To use time windows:
1. On the METHOD EDITOR, select INITIAL WASTE AND TIME. 

The TIME WINDOWS window opens.
2. Enter a start time and end time. All times are relative to 

start of the run just following the sample injection.
3. Choose a peak collection mode. If you select Peaks, the 

module collects fluid only when the time window is active 
and a peak is present. If you select All, the module collects 
all fluid during the time window regardless of the peak 
state. Detected peaks still trigger tube advances.

4. Enter more time windows as needed. You can define up to 
six time windows.

• PEAK COLLECTION — There are three peak collection 
options: ALL, PEAKS, or NONE.
· The ALL option collects peak and non-peak fluid in 

tubes.
· The PEAKS option collects only peak fluid in tubes 

and diverts all other fluids to the waste port.
· The NONE option diverts all fluids, peak and 

non-peak, to the waste port. The NONE option is 
useful for developing custom methods that perform a 
column wash, system cleaning, or similar function 
where solvents and eluant do not need to be collected.

When using the ALL or PEAKS options, you can specify the 
maximum PEAK and NON-PEAK volumes to be collected in the 
tubes. Be sure to enter volumes less than the maximum tube 
capacity. Different peak and non-peak tube volumes can be used 
to conserve tubes when using the All peak collection mode by col-
lecting large volumes of non-peak fluid while creating more and 
smaller fraction volumes of fluids of interest.
The fraction collector advances to the next tube whenever a peak 
is detected. Some notes about collector behavior:
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• The system advances to the next tube if a new peak is 
detected before completing the last one (sometimes 
called a “double advance”).

• Tubes may also advance when using multiple detectors, 
depending on impurities or sensitivity to a given 
compound by each detector.

• Slope and threshold detection methods use algorithms 
which optimize the peak detection. For example, peak 
detection includes a hysteresis to reduce the likelihood 
of multiple tube advances that may occur if there is 
noise at the beginning or tail end of a peak.

Tube Volume – Options in this section allow you to specify 
the tube volume for collected fluids. This volume can be the 
default maximum volume for that tube size (Max option) as 
entered in the CONFIGURATION window, or a 
method-specific volume that is less than the capacity 
defined by the CONFIGURATION window. 

Peak Detection  – This section of the METHOD EDITOR 
window contains option buttons to enable and disable 
various peak detection options. When an option is enabled, 
the window also allows you to modify the setting details for 
that peak detection option. All enabled options are 
displayed on the chromatogram. 

Note
You can select up to four peak detection options on the 
ACCQPrep systems. If more than one option is selected, such 
as 1 with  2, the system considers a peak to be present 
when either option is true (a logical OR).

See Section 4.3.2, Wavelength Peak Detection for more infor-
mation about peak detection settings. Some useful method 
options are described below:

• 1 and 2 (wavelength 1 and 2) — Provides primary and 
secondary wavelength detection. Type or select the peak 
detection wavelength in nanometers, then select 
DETAILS to configure additional settings.

Note
If both Slope and Threshold peak detection methods are 
checked, the system considers a peak to be present when any 
one condition is met. This logical OR operator means that the 
system will cut a peak when either the Slope condition is true, 
or when the Threshold condition is true.

· MONITOR - Select to only use the detection source as a 
monitor. When selected, the detection source is 
displayed as a trace on the gradient plot area but is 
not used to cut peaks.
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• ALL WAVELENGTH DETECTION — Detects peaks within a 
user-selected range of wavelengths. When enabled, 
select the DETAILS button to configure additional 
settings. 

• ELS DETECTOR — The evaporative light scattering 
(ELS) detector on an ACCQPrep system. 

• MASS SPECTROMETER (PurIon systems only) — Monitors 
or detects compounds with a PurIon mass spectrometer 
system.

• ION SETTINGS – Sets ionization parameters to enhance 
detection of molecular ion peaks.

• PURITY MEASURE — Displays a ratio of the selected 
wavelengths if two absorbance wavelengths are used. 
The ratio trace is often a useful indicator of purity.

Selecting PEAK DETECTION DETAILS opens additional detector 
options for 1 and 2, ALL WAVELENGTH DETECTION, MASS SPEC-
TROMETER, ELS DETECTION, and PURITY MEASURE peak 
detection. See Section 4.3.2 for detailed information about peak 
detection settings.

Saving Changes to the Method File – After you have 
edited the method file, you can save the changes for future 
use:
1. Select the SAVE AS. The FILES window opens.
2. Give the method file a descriptive name, then select SAVE.

The method file is stored by the ACCQPrep system and will be 
available for future runs.

4.4.2 An Alternative Way to 
Create Method Files

Other than by editing a method file on the ACCQPrep system, 
there is another way to create method files:
Extracting a Method File from a Previous Run – After 

the run, you can extract the run parameters as a method 
file so that it can be used on future runs. To do so, open the 
Run file and select EXTRACT METHOD. The system loads a 
new method with identical run parameters. You can then 
save the method using FILE > SAVE METHOD AS.

4.4.3 Defining a Gradient The simplest way to change the gradient is to select and drag the 
inflection points that define its shape. Add a point by selecting 
the INSERT button, then select a place on the gradient curve to 
add a point. You can then drag the new point to a location. Delete 
a point by selecting the DELETE button and then selecting the 
undesired inflection point.
The methods above work in both the MAIN window and METHOD 
EDITOR window. Alternatively, you can modify, add, insert, and 
delete points using a tabular view on the METHOD EDITOR
window. Select the EDIT GRADIENT button to open this view, then 
use the controls to modify the settings. Select the EDIT GRADIENT 
button again to close the table view.
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4.4.4 Real-time Gradient 
Editing

The gradient shape can be changed during the run. Any time 
after the fraction collector has positioned the drop former over 
the first tube, select and drag the points on the gradient plot area 
of the MAIN window. You can also add or remove points by 
selecting the INSERT or DELETE POINT buttons. The INSERT
button allows you to add a single point when you select a place on 
the gradient profile. Repeat this action to add more points. The 
DELETE button allows you to remove a single point when you 
select it.

Note
Only the portion of the gradient that has not yet occurred 
during the run can be modified.

4.4.5 Stacked Injections Stacked Injections save time and solvent when running multiple 
injections. Stacked injections options are found on the RUN 
REQUIREMENTS window that appears when you START a run. See 
Section 3.3.9  Stacked Injections for step-by-step instructions and 
information about settings. 

4.4.6 Monitoring the Purity 
Measure

When using two wavelength detection options, you can also 
display a ratio of the two wavelengths, which at times can 
provide the best indication of compound purity. Refer to the fol-
lowing discussion.
If a pure compound is eluting, the absorbance is linearly related 
to the concentration of the compound in the solvent. If the com-
pound absorbs differently at different wavelengths, the absor-
bance at each wavelength may be different but still linearly 
related. For example, assume a compound eluting from the 
system has an absorbance equal to 2 times the concentration at 
254 nm. This same compound at 220 nm has an absorbance of 1.5 
times the concentration. The ratio of these signals is 1.33. Since 
the relationship of absorbance to concentration is not variable, 
the ratio remains steady while the concentration changes from 
the beginning to the end of the peak. During the duration of the 
peak, the ratio will be 1.33, and this constant value is displayed 
as a horizontal line.
Now assume a case where there is a second compound eluting, 
only slightly shifted in time from the original compound. Pos-
sibly, the detection absorbance trace alone would indicate a 
single, valid chromatographic peak. In reality, it is a combination 
of two peaks. By monitoring a second wavelength, it may be pos-
sible to reveal the second compound. Because of the slight shift in 
time and the different absorbance properties of the two com-
pounds, the changing ratio during the detected peak would 
reveal the impurity. Therefore, you can assume that if the ratio 
is not constant for the entire duration of the peak, the compound 
that is eluting may not be pure.
The following controls can be found on the PURITY MEASURE
window (METHOD EDITOR > ALL WAVELENGTH DETECTION > 
DETAILS >).
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• SHOW SPECTRAL PURITY measures purity by using a 
comparison of UV-spectra measured at differing times. 
The algorithm used is the “similarity index”.

• SPECTRAL PURITY DETECTION allows fractionation based 
on spectral purity. However, the spectral purity 
algorithm doesn't work on saturated peaks (flat on top 
due to detector saturation).

• SHOW RATIO displays the ratio when using two absor-
bance wavelengths.

4.4.7 Viewing Runs After completing a run, the PeakTrak MAIN window is used to 
display all collected run data. You can also open previous runs to 
view the chromatogram and the peak/tube locations. To open a 
previous run:

1. From the MAIN window, select FILE > OPEN, or select the 
OPEN button. The FILES window is displayed.

2. Choose a Run file and select the OPEN button. The RUN 
VIEWER window opens.

Included on the PeakTrak RUN VIEWER:
• Rack and tube information — The left pane of the 

window lists the current rack, a map for that rack, and a 
table that lists the peaks and their corresponding tube 
numbers. If the window is currently displaying the 
collection parameters, select the DISPLAY RACK button 
to view this information. On PurIon equipped systems, 
the mass spectrum of the fraction contents can be 
displayed by pushing the MS button and selecting a 
tube.

• Method parameters — Select DISPLAY METHOD to view a 
summary of the peak detection and collection settings 
for the run.

• Chromatogram — Displayed on the right side and 
identified by the sample name in the window’s title bar.

• OPTION buttons — Quickly access frequently used 
commands while viewing a run:

PRINT — Prints a run summary. When viewing the 
run from a remote personal computer, you can 

print the summary on any installed printer. If you are 
attempting to print from the system’s touch panel dis-
play, you must first set up Network Printing in the 
NETWORK CONFIGURATION settings.

SAVE AS PDF — Saves the run summary as a PDF 
file. When viewing the run from a remote personal 
computer, you can save the summary to any con-

nected storage device. If you are attempting to save a 
PDF file from the touch panel display, insert a USB 
Flash drive in the USB port below the display panel.

SAVE AS TEXT — Saves the run summary as an 
ASCII text file. When viewing the run from a 

remote personal computer, you can save the summary. 

T
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If you are attempting to save a TXT file from the touch 
panel display, insert a USB Flash drive in the USB 
port below the display panel.

• Use the touch panel, pinch zoom or pan to view the 
results screen in greater detail. Pan requires the use of 
two fingers to differentiate a pan action from a select 
action. You can also select ZOOM IN OR ZOOM OUT.

• MODIFY VIEW — Opens a window from which you can 
set the left and right Y-axis scales. These scales are 
controlled by the ABSORBANCE and %B UPPER LIMIT. 
Selecting SHOW THRESHOLD LEVEL shows the threshold 
level setting of all detectors except the mass 
spectrometer. The threshold levels are color-coded to the 
detector trace.

• REFERENCE CHROMATOGRAM - Allows you to pull up a 
previous run to compare to current run. Time scaling 
matches the longest run. If runs are of different length, 
the shorter run will be missing that part of the 
chromatogram. Also, zooming on one spectrum also 
scales the other spectrum similarly.

• MS - Displays a mass spectrum (PurIon systems only). 
Selecting in the Chromatogram window displays a mass 
spectrum at that point during the run. Selecting on a 
tube in the rack map shows the mass spectrum of the 
contents of that fraction.

• UV (is displayed as “vis” on UV-Vis equipped systems) - 
Displays a UV or UV-visible spectrum (UV-Vis systems 
only). Selection within the Chromatogram window 
display a mass spectrum at that point during the run.

• STACK INJECTIONS — Opens the STACKED INJECTIONS 
window, from which time windows can be adjusted. See 
Section 3.3.9  Stacked Injections.

• EXTRACT METHOD — Loads a new method file on the 
basis of the parameters for the run you are viewing.

• EXTRACT TO — Lists columns to extract to.
• CLOSE — Closes the run file view when you are done 

viewing it
General instructions for reading the data – Most ele-

ments on the window are color-keyed to help you locate the 
tubes containing the peaks of interest. A color bar below 
each collected peak matches a tube in the map on the left. 
The tube map provides a visual representation of the tubes 
that contain the peaks of interest. If you want to identify 
the tube by number, refer to the table below the rack dia-
gram. 
 
If the run used multiple racks, the PREVIOUS and NEXT 
RACK buttons are active. Select either to scroll through the 
available racks. The currently displayed rack is identified 
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by the letter shown below the rack.

Reading the Chromatogram – The plot area displays the 
following:

· The red absorbance trace produced by the system’s 
peak detector. Absorbance units (also shown in red) 
that correspond to this trace are shown on the left 
Y-axis.

· Purple absorbance and green purity measurement 
traces. These may be visible if you are monitoring a 
second wavelength.

· Green traces. These are from the ELSD.
· The PurIon traces color coded with the selected 

masses below the graph Y-axis.
· The blue gradient curve that was used during the 

run. The % Co-solvent scale is shown in blue on the 
right Y-axis.

· The X-axis that depicts the run time, shown as 
minutes.

· Vertical lines that appear at intervals along the 
X-axis. These lines indicate collection tube changes. 
To prevent the plot area from being obscured by tube 
change marks, PeakTrak may limit the number of 
marks.

4.4.8 Manual Control of the 
ACCQPrep SFC

Manual Control can assist with method development, mainte-
nance of the system plumbing, and system troubleshooting. To 
manually control the ACCQPrep SFC system, first open the 
MANUAL CONTROL window by selecting TOOL > MANUAL 
CONTROL.

Pumping Solvents To pump a mixture and adjust the PERCENT COSOLVENT setting 
and then select PUMP% COSOLVENT. When finished, select STOP
FLOW.
You can control the flow rate by adjusting the FLOW RATE
mL/min setting.
By default, the system pumps the solvent directly to the waste 
port. You can also pump the solvent into a fraction valve position 
or to a collection tube on the AutoSampler. To do so, select the 
COLLECTION option and then select a fraction valve position tube 
(“next” or specific tube number).

Raw Lamp Energy The left side of the MANUAL CONTROL window shows a Raw 
Lamp Energy gauge. It provides an indication of the UV light 
measured by the optical detection system at 254 nm. High lamp 
energy (green) means that the flow cell easily passes through a 
sufficient UV light source. Lower lamp energy (yellow or red) 
means that either the light source is weak or that the flow cell is 
obstructed.

• Green – Lamp energy is sufficient to detect peaks up to 
2.4 Absorbance Units.
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• Red – Lamp energy is obstructed to a degree that the 
system might not reliably detect peaks. If you attempt to 
operate the system, peak collection will be forced to 
collect all. This prevents desired compounds from being 
diverted to waste.

Depending on what you are doing with the MANUAL CONTROL 
functions, low lamp energy could indicate normal operation. For 
example, a UV-absorbing compound could be present in the flow 
cell as you are pumping solvent, or the selected solvent absorbs 
UV light at 254 nm. Or, abnormal operation could be indicated, 
such as a flow cell blocked by a compound that has precipitated 
or by a film built up on the flow cell. 



5-1EAR99 Technology Subject to Restrictions Contained on the Cover Page

ACCQPrep® SFC

Section 5  Maintenance 

5.1 Introduction This section covers some common maintenance routines for the 
ACCQPrep SFC system. 

5.1.1 Cleaning To clean the exterior surfaces, use a cleaning cloth dampened 
with a mixture of distilled water and a mild detergent. Use iso-
propyl alcohol for tougher stains.
On printed areas such as labels, avoid rubbing vigorously or 
using aggressive solvents like acetone. These will ruin the 
printed text.

CAUTION
Do not immerse the instrument in a water bath or subject it to a 
liquid spray. The instrument is not watertight and these actions 
could damage the internal electronics.

5.1.2 Collection Rack and 
Tray Cleaning

WARNING
Risk of fire or equipment damage. Unclean collection racks 
and tray might have inhibited conductive properties. 
The racks and tray must be kept clean to dissipate 
static electricity.

The collection tube racks and tray are made of conductive plastic. 
Dirt, film, or coatings might prevent their ability to dissipate 
static electricity. To avoid problems that possibly result from an 
electrostatic discharge, clean the racks and tray monthly. Use 
distilled water with a mild detergent. For tougher stains, use iso-
propyl alcohol.

5.2 System Standby and 
Shut Down

During extended periods of inactivity, you can place the system in 
STANDBY to conserve power. To do so, log off the system (FILE > 
LOGOUT) and press the power button (  )on the front of the unit.
When in the STANDBY state, normal system operation is no 
longer available from the touchscreen or remotely. However, 
some internal components are still powered.
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WARNING
As long as the AC mains power cord is connected and rear 
circuit breakers are in the ON position, power is inside the 
unit. The mains power cord is the disconnect device. 
Position the ACCQPrep system so that the power cord can 
be unplugged, or use a power strip where the plug can 
quickly be removed from the outlet in the event of an 
emergency.

When you first place the system in STANDBY, internal compo-
nents continue to operate for almost one minute while per-
forming file maintenance and preparing the system for possible 
power removal.

CAUTION
Removing the AC mains power cord or turning off the rear 
circuit breakers before the file maintenance is complete might 
corrupt files on the internal hard drive. These corrupted files 
can cause abnormal operation or a complete system failure 
that requires service. Unless power must be removed due to 
an emergency, always wait at least one minute after placing 
the system in STANDBY before removing the AC mains power 
cord or turning off the rear circuit breakers.

5.2.1 Tubing Inspection

WARNING
Risk of fire or equipment damage. Faulty tubing, fittings, 
and drains may allow organic solvents to pool in unsafe 
areas, creating a potential for dangerous levels of 
flammable vapors. Improper draining may damage the 
instrument’s internal components.

Perform a tubing inspection monthly:
1. Visually inspect the solvent, waste, and drain tubing. The 

tubing must be free of any damage, kinks, or deterioration. 
Fittings must show no signs of leaks.

2. Check pumps at the front of the pump module for leaks, 
frosting, and condensation.

3. Visually inspect the back-side tubing for leaks, frosting, 
and condensation.

Correct any deficiencies before returning the instrument to oper-
ation.
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5.3 Preventive 
Maintenance

The system requires preventive maintenance for safe and 
re l ia bl e  o pera tio n.  A Preventi ve  Mai ntena nce  Kit 
(PN 60-5267-020) is available from Teledyne LABS for this 
purpose. 
Refer to the schedule below for the minimum periodic mainte-
nance requirements.
As Needed  – Perform these tasks as conditions require:

• Cleaning (Section 5.1.1).
• Quick flow cell cleaning when recommended by a system 

alert message (Section 5.4).
• Wipe the cone on PurIon system with a wipe soaked 

with methanol or water to remove visible residue near 
cone inlet. (PurIon systems only.)

Every Run  – Perform these tasks at the end of each run:
• Allow the separation run to finish with a high 

percentage of co-solvent to flush residual compounds 
from the column, internal tubing, and flow cell. If 
performing stacked injections or multiple injections of 
same sample, a flush is also necessary. Refer to section 
5.4.

• Allow cone wash to run to completion (PurIon systems 
only) to wash residual compounds from the fluid 
interface, probe, and to clean the cone area.

• Allow the sample probe wash to run to completion to 
wash residual compounds from the sample line and from 
the ELSD (if installed) flow path.

Weekly – Perform these tasks at least weekly, and more fre-
quently if conditions warrant:

• Make sure that the chiller liquid is at an adequate level.
· Make sure the chiller liquid level is between 

1.0"–2.6" from the top edge of the internal reservoir.
• Make sure that the chiller is cold.

· Make sure that chiller is cooling the liquid to set 
temperature by checking the LCD display on the 
chiller.

• Make sure that the chiller has adequate flow.
· Make sure that liquid is flowing through chiller 

tubing to the CO2 pump heads in the SFC pump box.
Monthly – Perform these tasks at least monthly, and more fre-
quently if conditions warrant:

• Tubing Inspection (Section 5.2.1).
• Collection rack and tray cleaning (Section 5.1.2).
• Monthly flow cell cleaning (Section 5.4.2).

Annually  – Perform these tasks at least annually, more fre-
quently if conditions warrant:

• Lamp replacement.
• Lamp fan cleaning.
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• Drop former alignment (if AutoSampler is installed).
• Fractionation valve rotor replacement.
• Change roughing pump oil (PurIon systems only).
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5.4 Flow Cell Cleaning

5.4.1 Post Separation As a preventive measure, all default column methods finish the 
separation run with a high percentage of co-solvent (Figure 5-1). 
This brief time (one to six column volumes) of strong solvent 
flushes residual compounds from the column, flow cell, and 
internal tubing.

Figure 5-1 Default post-separation column and flow cell 
flush

Skipping the post-separation flush may cause residual com-
pounds to build up and crystallize, which might result in:

• Cross contaminating later separation runs.
• Higher operating pressures.
• Reduced flow cell lamp energy.
• A noisy baseline on the absorbance trace.
• Frequent messages recommending flow cell cleaning 

(Figure 5-2).
Typically, chemists STOP FLOW and then TERMINATE the run 
after the last compound elutes. This action skips the post-sepa-
ration flush. If any of the conditions listed above appear, consider 
allowing some of the runs to continue through the flush, or run a 
high percentage of co-solvent through the system for a few 
minutes at the end of each day.
If stacked injections or multiple injection sequences were run, 
allow a post-separation flush to run.
If the separation runs always continue through the flush and the 
conditions still occur frequently, edit the DEFAULT COLUMN 
METHODs to extend the flush duration.
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CAUTION
Do not use polar, basic solvent systems with silica column 
media. These solvent systems may break down the silica 
structure, possibly causing obstructions in the flow path. 
Examples of such solvent systems include, but are not limited 
to, those containing more than 20% methanol with ammonium 
hydroxide.

5.4.2 Flow Cell Cleaning 
when Recommended

The raw lamp energy gauge measures the cleanliness of the flow 
cell. A dirty flow cell may cause the detector signal to appear 
“noisy.”
Perform Flow Cell Cleaning when Recommended (Section 5.4.2) 
once a month for preventive maintenance of the flow cell.
Selecting TOOLS > MANUAL CONTROL opens the MANUAL 
CONTROL window on which the raw lamp energy gauge is dis-
played. The gauge has two ranges: red and green (Figure 5-2).

Figure 5-2 Raw lamp energy gauge

• Red – Indicates that lamp energy is obstructed to a 
degree that the system might not reliably detect peaks. 
If you attempt to operate the system, peak collection will 
be forced to collect all. This prevents diverting desired 
compounds to waste.

• Green – Indicates that lamp energy is sufficient to 
detect peaks within typical system limits.

When the lamp energy is lower than normal (Figure 5-2), the 
system will recommend flow cell cleaning before starting a sepa-
ration run.
When the system displays this message, you can:

• Cancel Run (recommended) – Select this to perform a 
quick cleaning described in the following steps.

• Continue Collect All – Select this to ignore the 
message. Because the peak detection operation might be 
impaired, the system automatically collects all fluids to 
avoid diverting compounds of interest to waste.

• Help – Displays the flow cell cleaning on-line help topic.
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To perform a quick cleaning after selecting the CANCEL RUN:
1. Install a union in one of the column positions. Correctly 

installed, this turns that position into a bypass.

Note
You can rename the column position using TOOLS > CONFIGU-
RATION > PREP SFC. Giving the COLUMN POSITION a descriptive 
name like “Bypass” will make it easier to find in step 5a.

2. Using the control on the front of the unit, prime the co-sol-
vent inlet lines: first with methanol, then with acetone.

3. Open TOOLS > METHOD EDITOR and change
· the PREHEATER temperature to 70° C, and
· the BPR PRESSURE to 160 BAR (2321 psi). 
Save these settings by selecting the SAVE icon, then EXIT.

4. Select TOOLS > MANUAL CONTROL. This opens the MANUAL 
CONTROL window.

Figure 5-3 Manual Control Settings - Quick Cleaning

5. Make the following settings on the MANUAL CONTROL win-
dow (Figure 5-3):
a. Verify that the COLUMN position that contains the 

union inserted in Step 1 is selected.
b. Set the FLOW RATE to 80 mL/minute.
c. Set SAMPLE LOOP to Through Sample Loop.
d. Set COLLECTION to Waste.
e. Verify that the COSOLVENT selected is the solvent inlet 

line submerged in the Acetone solvent supply con-
tainer.
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CAUTION
Choosing the wrong column position in Step 4a could cause 
the solvent mixture to be pumped through a column. If the mix-
ture is incompatible with the column, it could be damaged.

6. Set the PERCENT COSOLVENT to 5% and select 
PUMP 5% COSOLVENT. Allow the pump to run for 2 min-
utes.

7. Change the PERCENT COSOLVENT to 30%. Run this for 
2 minutes.

8. Change PERCENT COSOLVENT to 70%. Note that because 
acetone absorbs light at 254 nm, the lamp reading may 
remain in the red.

9. Stop the pump, then select the solvent line containing 
methanol. Run this in the same fashion as steps 5-7, with 
30% and then 70% co-solvent for 2 minutes each.

After the acetone is washed from the system, the light intensity 
should read in the green on the lamp energy gauge.
If washing with methanol fails to restore the lamp energy out of 
the  red,  contact the Teledyne ISCO Technical service 
department.

Note
Over time, pumping co-solvent at a moderate flow rate (50 to 
80 mL/min) will usually solubilize obstructions, including those 
resulting from the last run or left over from the cleaning proce-
dure. Generally, the recommended solvent is the highest polar-
ity solvent that you have recently used.

5.5 ACCQPrep SFC 
Maintenance

5.5.1 Maintenance Tools 
and Instructions

ACCQPrep SFC systems include an accessory kit containing 
spare rotors, parts, and other useful items for periodic mainte-
nance.
Often, this requires gaining access to the pump compartment by 
gripping the edges of the front panel and pulling forward on both 
sides (Figure 5-4).
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Figure 5-4 Front panel of the ACCQPrep SFC system

5.5.2 Injection Valve Rotor Failure of the injection valve rotor requires its removal, cleaning, 
or (potentially) its replacement. Symptoms of failure are leaking, 
high pressure caused by clogging, and flow to undesired flow 
paths.

Figure 5-5 The injection valve rotor assembly

Note
The injection valve rotor is a common wear part. Since it is a 
sealing surface, it can be damaged by particulates in the sam-
ple. To prolong the life of the rotor, ensure that your sample is 
properly filtered (<20 µm) to prevent premature failure.

To replace to rotor, follow these steps:
Removing the Injection 
Valve Rotor

1. Have the Accessory Kit (PN 60-5269-011) on hand. This kit 
is included with the ACCQPrep SFC system and includes 
the rotor for this procedure.

Note
For other parts for your ACCQPrep SFC system, visi t 
https: //store. teledyneisco.com, or contact  your local 
Teledyne LABS representative.

2. Do a system vent. Select TOOLS > MANUAL CONTROL > 
VENT SYSTEM PRESSURE). Allow at lease 15 minutes for the 
instrument to depressurize. You can monitor the System 
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and BPR pressure reading in the System Status Bar at the 
top left hand corner of the touchscreen.

3. Turn off the power to the system. 
4. Access the column oven module. Remove the valve thumb-

screw by hand. If the thumbscrew does not move by hand, 
gently use pliers or channel locks to loosen, then finish 
removal by hand.

CAUTION
Do not use an Allen wrench or other driver to loosen or tighten 
the valve. Turn it using the knurled outer portion only.

Figure 5-6 Rotor thumbscrew removal

5. Locate the rotor inside and slip out by using a magnet.

6. Make note of marking on rotor, as it needs to go back in the 
same orientation. 
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· Use a marker to mark the front face of the rotor or 
make note of the embossed letter on the rear edge of 
the rotor, as it needs to go back in the same orien-
tation.

7. Install new rotor by performing the removal steps in the 
reverse order. Installation is similar to removal. When 
inserting the rotor, ensure that it is oriented in the same 
direction as it was when removed.

5.5.3 Column Select Valve 
Rotor Replacement

Failure of the column select valve rotor requires its removal, 
cleaning, or (potentially) its replacement. Symptoms of failure 
are leaking to the exterior of the valve, high pressure caused by 
clogging, and leaking to an undesired column.
To replace to rotor, follow these steps:

1. Have the Accessory Kit (PN 60-5269-011) on hand. This kit 
is included with the ACCQPrep SFC system and includes 
the rotor for this procedure.

2. Do a system vent. Select TOOLS > MANUAL CONTROL > 
VENT SYSTEM PRESSURE. Allow at lease 15 minutes for the 
instrument to depressurize. You can monitor the System 
and BPR pressure reading in the System Status Bar at the 
top left hand corner of the touchscreen.

3. Turn off the power to the system. 
4. Access the column oven module. Using a 5/8" open-faced 

wrench (or adjustable open-faced wrench) to loosen the 
rotor cap.

Figure 5-7 Loosening the rotor cap

5. Finish removing the rotor cap by hand.
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Figure 5-8 Removing the rotor cap

6. Pull out the rotor using a magnet to grab it. 

Figure 5-9 Removing the rotor

7. Install new rotor by performing the removal steps in the 
reverse order. Installing the new rotor is aided by using 
needle-nose pliers. Take care to not scratch the rotor.

Figure 5-10Tightening the new rotor

8. Test new rotor by running the unit in Manual Control and 
verifying that there is flow to each column position without 
leaking or over-pressurization errors.

5.5.4 Fractionation Valve 
Rotor Replacement

Failure of the fractionation valve rotor requires its removal, 
cleaning, or (potentially) its replacement. Symptoms of failure 
are leaking, flow to undesired ports, overpressure, and fraction 
valve error messages.
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Figure 5-11The fractionation valve

To replace to rotor, follow these steps:
1. Have the Accessory Kit (PN 60-5269-011) on hand. This kit 

is included with the ACCQPrep SFC system and includes 
the rotor for this procedure.

2. Do a system vent. Select TOOLS > MANUAL CONTROL > 
VENT SYSTEM PRESSURE). Allow at lease 15 minutes for the 
instrument to depressurize. You can monitor the System 
and BPR pressure reading in the SYSTEM STATUS BAR at 
the top left hand corner of the touchscreen.

3. Turn off the power to the system. Disconnect any tubing 
lines connected to the fraction valve.

4. Using a Phillips screwdriver, remove the four screws 
securing the case top of the control module. Set the screws 
and the case aside.

Figure 5-12Control module case top

5. Remove fractionation valve bracket by removing the two 
nuts that secure its mounting bracket to the side of the 
chassis. Use a 5/16" nut driver or wrench. Be sure to 
unplug the USB and power connectors as well, noting their 
locations.
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Figure 5-13The fractionation valve mounted (left) and 
removed (right)

6. Locate and remove the Allen nuts using a 7/64" Allen 
wrench.

Figure 5-14Loosening of the fractionation valve stator

7. With all mounting Allen nuts removed, pull the stator 
away from the valve body. It it not necessary to remove the 
retaining clip the holds the stator to the mounting bracket.
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Figure 5-15Removal of the fractionation valve stator

8. Slip out the rotor from the valve. This may require the use 
of needle-nose pliers or another tool, but take care not to 
scratch any surfaces of the valve.

Figure 5-16Removal of the fractionation valve rotor

9. Install the new rotor with the flow channel facing towards 
the stator face.

Figure 5-17Installation of the fractionation valve rotor

Stator

Rotor

Valve 
Body

Mounting 
clip
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10. Line up the stator face with the 1 port near the 12 o’clock 
position. The stator face will not go into position unless the 
offset mounting pins are aligned.

Figure 5-18Reinstallation of the fractionation valve stator

11. Reinstall the mounting Allen head nuts in a criss-cross 
pattern as illustrated.

Figure 5-19Fastening the fractionation valve stator

12. Reinstall the fractionation valve assembly in the 
ACCQPrep SFC unit chassis, taking care to reattach the 
USB and power cables.

13. Test new rotor by running the unit in Manual Control 
through the fraction ports and to waste.

5.6 AutoSampler 
Maintenance
Peristaltic Tubing 
Replacement

For peristaltic tubing for your ACCQPrep SFC system, visit 
https://store.teledyneisco.com.

3rd

1st

2nd

4th



ACCQPrep® SFC 
Section 5   Maintenance

5-17EAR99 Technology Subject to Restrictions Contained on the Cover Page

Figure 5-20The peristaltic pump at the back of the AutoSampler 

1. At the pump: push the levers at the top and bottom of each 
tube retaining clip, then pull the clips out (Figure 5-21). 

Figure 5-21Removing a retaining clip

2. Disconnect the upper and lower clear tubing from each per-
istaltic tube (Figure 5-22).

Figure 5-22Disconnecting the clear tubing

3. Remove the peristaltic tubing. Clips on the tubing that 
secure the ends to the inner edge of the pump slide out 
(Figure 5-23).
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Figure 5-23Removing the tubing

4. Install the new peristaltic tubing with the thicker tubing 
towards the AutoSampler.
· Install the new peristaltic tubing with the 3.2 mm ID 

tubing (thicker) towards the AutoSampler (ports 
labeled 2 and 4). 2.0 mm ID tubing (thinner) furthest 
away from the AutoSampler (ports labeled 1 and 3).

5. Reconnect the clear tubing. Be sure that the numbers on 
the tubes correspond to the numbers on the pump.

6. Replace the tubing retaining clips.

5.7 PurIon Maintenance

5.7.1 ESI and APCI Removal 
from PurIon S and 
PurIon L

Refer to Figure 5-24.
1. Place the mass spectrometer in STANDBY mode.
2. Unscrew the ¼-28 PEEK fitting at the top of the ion source 

housing.
3. Loosen the two clamps at both sides.
4. Gently lift and pull out the source housing.

Figure 5-24ESI and APCI removal from PurIon S and PurIon L



ACCQPrep® SFC 
Section 5   Maintenance

5-19EAR99 Technology Subject to Restrictions Contained on the Cover Page

5.7.2 ESI and APCI 
Replacement PurIon S 
and PurIon L

1. Carefully place the ion source housing on top of the base 
plate and line up with the rear electrical connection. Push 
down until source chamber is seated evenly across the base 
plate.

2. Lock down two housing clamps at both sides.
3. Finger-tighten the ¼-28 PEEK fitting at the top of the 

source housing.

5.7.3 Cleaning the 
Ionization Source 
Capillary

Plugging of the capillary (either in the ESI or APCI probe) causes 
the pressure of the carrier fluid from the fluid interface to exceed 
the maximum operating pressure indicated by Error 310 or Error 
316. This error can be avoided by filtering directly injected 
samples through a 0.45 µ syringe filter. To unplug the capillary, 
complete the following:

1. Using adapters as needed, connect a 1 mL syringe to the 
ESI or APCI capillary, then push fluid through to remove 
plug. If this procedure does not resolve the issue, an HPLC 
pump can be connected to the inlet fitting.

2. If this procedure fails to unplug the capillary, refer the 
instructions for the rebuild kit provided with your PurIon 
system.

3. Reinstall the probe following the appropriate procedures 
for your system.

5.7.4 Replacement of Ion 
Source Housing

1. Place the ion source housing on top of the base plate and 
line up with the rear electrical connection. Push down until 
source chamber is seated evenly across the base plate.

2. Finger tighten the two thumb screws and finger tighten 
the ¼-28 PTFE tube fitting labeled ‘heated desolvation’ on 
the side of the housing. 

5.7.5 Overpressure Error The fluid interface has a pressure transducer to monitor 
pressure of the carrier fluid. Since the sample is introduced at 
the splitter valve, plugs usually occur between the valve and the 
PurIon source sprayer. The most common location for a plug is 
within the probe capillary. The occurrence of plugs can be 
reduced by using a 0.45 µ syringe filter when injecting samples 
for Method Development and Ionization Settings. To trouble-
shoot an overpressure error, complete the following:

• If the error occurs during a run, select CONTINUE 
WITHOUT PurIon. The purification then continues 
without the PurIon signal or peak detection but relies on 
any other detector selected such as UV or ELSD. This 
allows the run to be completed before troubleshooting 
the plug.

• Use the menu item MS > MANUAL control.
• Select START CARRIER PUMP.
• Watch the pressure on the ribbon gauge.
• Loosen the fitting at the source inlet. If the pressure 

drops, then the source capillary is plugged.
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• If there is still an error or the pressure remains high, 
then the plug is between that point and the splitter 
valve (or the valve itself). Continue to loosen fittings 
going back the to the splitter valve until the error is 
corrected.

5.7.6 PurIon Cone Cleaning This error occurs if the capillary inlet to the PurIon vacuum 
region is restricted causing a higher vacuum reading than 
normal. PurIon S & L models compatible with the NextGen 
systems have an internal valve that allows removal of the cap-
illary inlet without venting the vacuum system to allow easy 
cleaning. Even with the easy cleaning capability, Teledyne LABS 
recommends keeping a spare capillary inlet cone assembly 
(PN 25-0000-085) to allow rapid replacement to minimize 
downtime while cleaning the plugged capillary.

5.7.7 Capillary Inlet Cone 
Removal

1. Set the PurIon to standby. 
2. Wait approximately 15 minutes for the cone to cool.
3. Remove the ion source assembly. See section 5.7.3.
4. Wearing gloves (typical lab gloves are usually sufficient), 

place your fingers on the top surface of the cone and turn 
counterclockwise to unscrew the capillary inlet cone. Often 
this is sufficient to remove the capillary. If you are unable 
to unscrew the part manually, use an adjustable wrench on 
the flats of the cone to unscrew them. The flats are not 
large, and they may be difficult to see while a wrench is 
seated on them. 

5. Remove the O-rings from the capillary inlet cone. 

5.7.8 Capillary Inlet Cone 
Cleaning

1. Remove the O-ring under the capillary base, then sonicate 
the capillary in a methonal:water (50:50) mixture for 
30 minutes (Figure 5-20).

Figure 5-25Location of O-Ring

2. If heavily contaminated, sonicate in methanol:water + 1% 
formic acid (50:50) mixture for an hour.

3. Rinse the capillary thoroughly with acetone, isopropanol, 
methanol then dry the capillary using nitrogen air.

5.7.9 Capillary Inlet Cone 
Installation

1. Ensure that the O-ring seals are in position. 
2. Place the capillary inlet cone into the opening and press 

down until the threads are able to engage. There may be 
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slight restriction in a downward motion as the part is 
almost completely inserted. This is the capillary opening 
the valve to the vacuum region.

3. Screw the capillary inlet cone into the inlet. Finger tight is 
sufficient as long as the part is fully seated.

4. Replace the ion source. 
5. Place the PurIon in the operate mode.

5.7.10 PurIon 
Troubleshooting

If your instrument stops working and the touch panel display is 
off, check the line cord connection.
If the line cord is connected properly, check circuit breaker on the 
system’s rear panel to ensure it is switched to the ON position.

Table 5-1  Common PurIon 
Error Codes and Resolutions 

PurIon temperatures are stabilizing.
[r] seconds remain. (where [r] is a number)

The PurIon has several areas with heaters. The software 
has a set timer to allow temperatures to come up to oper-
ating conditions. After that time, a separate error is thrown 
if the heaters are not within an acceptable band. The 
default time is 300 seconds after entering the operate 
condition.
During the standby condition most heaters are set to OFF 
except the inlet capillary with is set to 50 °C during 
standby.

The PurIon vacuum level is too low to operate. Please 
verify that the roughing pump is on and operating cor-
rectly.
Pirani Pressure: [s1] mbar. (where s1 is the vacuum read-
ing).

The Pirani pressure must be below 5.5E-3 mbar before 
the PurIon turbo pump will operate. This message 
appears when placing the PurIon in operate without turn-
ing on the roughing pump,
This error generally occurs if the user forgets to turn the 
roughing pump back on after cleaning the capillary or 
changing the pump oil.

The PurIon has been shut down. It will be unavailable for 
use until the ACCQPrep has been rebooted. Be sure that 
the PurIon and fluid interface are both turned on before 
rebooting the ACCQPrep. 

This message is displayed after the PurIon has been suc-
cessfully shut down through the SHUTDOWN command. It 
serves as a reminder that an ACCQPrep reboot will be 
necessary for the PurIon to be enabled again by the sys-
tem.

The splitter valve seals have exceeded their recom-
mended life. The PurIon will continue to operate, but 
there is an increased possibility of leakage at the splitter 
valve and loss of PurIon detection during a separation.

The splitter valve supplier has stated that typical valve life 
exceeds 1,000,000 actuations. After that time, there is no 
method of determining when it will leak. The valve can be 
rebuilt using the valve rebuild kit (PN 60-5234-629) or 
continue to use and monitor for leakage. Leakage should 
not drip out the bottom of the fluid interface front cover.

No ion source is detected on the PurIon. Verify that the 
ion source is properly installed and connected. If the 
source is still not detected, contact a qualified service 
technician. Error 309

The PurIon has reported that the ion source high voltage 
cable is not properly plugged into its socket. This is the 
cable with the round connector and is to the right and 
behind the ion source.
This generally occurs upon changing or cleaning probes.

A plug has occurred in the PurIon fluid lines. The separa-
tion can be continued without PurIon detection or contin-
ued if the plug is corrected. Error 310

This error message is displayed if a plug is detected 
during a separation.
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The PurIon inlet cone may be plugged, which could pre-
vent detection. Continued operation will not cause dam-
age. Contact a qualified service technician to clean the 
cone; Pirani Pressure: [s1] mbar. Error 315

During normal operation, the Pirani pressure should be 
>1.5E-3 mbar. Anything less is an indication of either par-
tial or complete plugging of the capillary cone entrance to 
the vacuum area. See cleaning the cone capillary (5.7.3).

A plug has occurred in the PurIon fluid lines. The plug 
must be corrected to allow continued operation. Error 
316.

This error occurs if the tubing is plugged while the 
method development screen is in use. See cleaning the 
probe capillary (5.7.3).

The ionization probe (ESI or APCI) isn’t fully seated into 
the ion source housing. Please ensure the probe is fully 
seated, then press OK to continue. Error 317.

On PurIon systems (not PurIon S or PurIon L), the probe 
isn’t seated properly. Loosen the thumbscrew on the front 
of the ion source housing, push down on the probe, then 
tighten the thumbscrew.

The fluid interface pressure is too low. Error 325 This could be due to lack of carrier fluid, loss of pump 
prime, or leakage.

Table 5-1  Common PurIon 
Error Codes and Resolutions 
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